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Read this User's Guide to use the printer safely and properly. Keep this manual in a place where you 
can quickly access it at any time. 
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Flora Digital Printing System 
 

Flora Digital Printing System, reserves the right to make changes without prior notice to the 
specifications and materials contained herein and shall not be responsible for any damages 
(including consequential) caused by reliance on the materials presented, including but not limited to 
typographical, arithmetic, or listing errors. 
 

This equipment has been tested and found to comply with the limits for a class A digital 
device. Pursuant to part 15 of the FCC Rules, these limits are designed to provide reasonable 
protection against harmful interference when the equipment is operated in a commercial 
environment. 
 

This equipment generates, uses, and can radiate radio frequency energy and used in 
accordance with the instruction manual, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful interference, in which the 
user will be required to correct the interference at his own expense. 
 

This printer is a color inkjet printer that uses a UV-curable ink, supports up to 2500mm of 
media width, and has a built-in USB interface. 
 
This manual, the F1-250UV User's Guide, describes the features of the printer, names of 
components, information needed before use, and basic operations, such as how to turn the power 
ON and OFF, loading and setting of the media and loading of ink. 
 
The following items should be read before proceeding to Section 1; 

− Contents of the package 
− Safety precautions 
− Handling precautions 
− Notion 

 
Read these items to use the printer safely and properly. Keep this manual in a place where you can 
quickly access it any time. 
 
 
Disclaimer 
 

     This is an alpha release of the User's Guide for Flora F1-250UV printer. We have made every effort to 
guarantee the accuracy and integrity of the information in this manual. If you find some errors or omissions, 
please bring them to our attention so we can check and correct them accordingly.  
 
     This manual can be used as a reference for operation and routine maintenance of the Flora F1-250UV 
printers. It can not be a replacement for the formal training provided by Shenzhen Runtianzhi Image 
Technology Co., Ltd, regarding on how to operate the printers properly. Shenzhen Runtianzhi Image 
Technology Co., Ltd will not take any responsibility for the consequences of misusing this manual and 
appendix. 
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Manual Usage Conditions and Limitations 
 

      The manual includes patent information, which belongs to Shenzhen Runtianzhi Image Technology Co., 
Ltd., the purpose of which is to help the authorized customers. Without the written permission from RTZ 
Company and the public declaration, any content of this manual should not be used for other purposes.  
 
      The text and images are subject to change without prior notice. Any software mentioned in this 
manual is provided by permission. Use or copy of these softwares must be according and to follow prior 
regulations. If the information in this manual has changed, there will be no further notice unless it is specified.  
 
 
Contents of Package 
 

 The internal printer components, including the options, are installed on the main unit on delivery. The 
print heads and extension table assembly are included on a separated box within the main crate. 
 
If any parts are missing or damaged, contact the shop or dealership where you have purchased the product 
or the nearest service center. 
 
 
Printer Introduction 
 

 The Flora F1- 250UV printer is a wide format digital printer suitable for small up to medium size 
business use. It uses a UV curable ink, which is environment friendly. It provides high productivity and is 
capable to replace traditional silkscreen printing. This type of printer is widely used in the fields such as 
advertisement, packing, printing, interior decoration, POP board, glass work, flexible packaging, wooden 
work, printing circuit board, etc. 

 
 F1-250UV series printers uses drop-on-demand and Piezo-electric technology. It can print colorful 
and wide image by using the highest 1440x1440 dpi resolution. It can output any size of images with “tile” 
feature in the software. Indeed, it is a combination of roll-to-roll and rigid board printer. 
 
 
Table 1   General Features  

Item 
No D e s c r i p t i o n Specification 

1 Printing Method Drop-on-demand Piezo-electric 
2 No. of colors 5 (CMYK+White) 
3 Ink type UV curable 
4 Ink reservoir capacity (volume) 4 Li/color (refillable while printing is on progress) 
5 Outdoor Durability 2 years for Flora UV curable ink 

6 Media handling system Roll-to-Roll, single sheet, Indexing Conveyor Flat 
bed with vacuum 

7 Media types 

Roll-to-roll including paper, vinyl, adhesive back 
vinyl, fabrics, banners, PVC, etc and flat rigid 
boards including, corrugated foam, Plexiglas, 
Sheet metal, sheet film, ceramic tiles, etc. 

http://www.floradigital.com
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8 Maximum printing size 2.50 meters width and unlimited length 

9 Maximum media thickness 48 mm 
10 Rip software PhotoPrint V5.3 Flora edition (Windows Xp sp2) 

11 Driver software FloraPrint 
12 Color management ICC based color, density adjustment curves 
13 File format Bitmaps, Tiffs, Jpeg, Postcripts3, Eps, Pdf, etc. 
14 Work Flow Rip and Print 
15 Warranty 1 year (please consult your local dealer for details) 

 
 
 
Table 2 Technical Specification 

Item 
No D e s c r i p t i o n Specification 

1 Model Flora F1- 250UV 
2 Print Head Binary Drop-on-demand piezo-electric 

3 No. of print heads 15 (CMYK+White, 3 printheads/color) 

4 No of colors 5 

5 Printing resolution option 360x360, 360x1080, 720x720, 1440x1440 dpi 

6 Printing quality option Standard, High and Ultra 

7 Printing Speed 
Standard Quality: 54 m2/hr 
High Quality: 38 m2/hr 
Ultra Quality 28 m2/hr 

8 Media maximum width 2.53 m 

9 PC minimum operating 
requirement. 512Mb RAM, 40Gb HDD, Windows XP Service Pack 2 

11 Operating environment 220VAC/50-60Hz/Single Phase, 2 outlets 25 Amp each. 
Distortion: < 0.5% 

12 UV lamp power rating 700 W 

13 Room  t em per at u r e  20~ 30  ºC  
14 Hum i d i t y  40~ 70% 
15 D im ensi ons  L4 . 49m x  W  0. 99m  x  H 1 . 56m  

16 W eigh t  1050  K g  
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Table 3 Flora F1-250UV Printer Model Coding 
Code Explanation 

Flora Brand Name 

F1 The best, fastest, latest model 

250 250 cm maximum width of media it can print 
UV Ink Type 

 
 
 
About the manual 
 

 The manual provides the end user all the information related to the machine basic functions, 
software installation, machine parameter calibration, maintenance and troubleshooting of Flora F1-250UV. 
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Chapter 1  - Safety Operating Instructions 
 
 
1.1 Brief Introduction 

This chapter introduces the important safety information. Please read and understand the 
safety information carefully before operating the printer. 

 

1.2  Safety Information 
FLORA printer uses the following chemical substances 

• All kinds of printing media 
• UV Ink 
• Cleaning liquid (UV Flush) 

 

 1. 2.1 Solvent and Ink Properties 
• Solvent and Ink are flammable. 
• Eye contact with the ink and solvent will break the cornea and weaken the eyesight. 
• Contact lens should not be worn when operating printer or when there is no proper ventilation.  
• Wear safety glasses and gloves while flushing print heads, ink tube or moving the ink bottles or 

containers. 
• Solvent and ink can be irritating to eyes, throat and skin. Inhaling the ink fumes would result in 

swoon or other symptoms. 
• Solvent vapors are heavier than air and may flow and gather in low spot. 

 
 

 
 
 
 
 

 1.2.2  Danger of Fire and Explosion 
 
 
 
 
 
 
 1.2.3  Anti-ultraviolet radiation 
 
 
 
 
 
 1.2.4  Proper Ventilation and Exhaust System 
 
 
 

This caution symbol represents danger. If this sign is ignored it may lead to 
serious injury or damage to the printer. 

Open flames, heat energy or spark around the printer can trigger fire and explosion. 
• No smoking, pilot lights, open flames, stoves, heaters or halogen lights should be 

turned on within 5m distance from any edge of the printer. 
• No portable spark-producing equipment (static, electrical or Mechanical) within 

5m distance from any edge of the printer. 

• Wear UV protection glasses and gloves when operating the machine 
and avoid being too closer to UV lights. 

• When doing maintenance task or being close to the flatbed machine, 
UV lights must be shut off or close all UV protection doors. 

 

• The vacuum exhaust system must be functioning before the printer operates. 
• Do not ignore this safety warning sign to avoid accumulation of flammable 

fumes in the area. 
 

http://www.floradigital.com
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        1.2.5 Ink and solvent spillage, a potential risk of Fire and explosion 
 
 
 
 
 
 
 
 1.2.6  High voltage may shock people or trigger a fire 
 
 
 
 
 
 
 
 
 
 
 1.2.7 Printing media rolls are bulky and very heavy 
 
 
 
 
 
 
1.3  Fireproofing 

Ink and solvent should be clearly labeled and stored in a specific area for flammable liquid 
and should be in accordance with local regulations of fireproof and safety standard. Ensure that the 
specified fire extinguisher is always available near the storage area and should be cleared from any 
obstacle in case of emergency.  

  
 
1.4 Exhaust System 

The printing area should be equipped with sufficient exhaust system. The exhaust should be 
installed in such a way build up of fumes is minimized. Best location for the exhaust should be at 
lowest level, this way the fumes build-up is minimized. Solvent fumes are heavier than air, so fumes 
build-up concentrates on the lower level of the room. 

 
    
   Electrical installations inside the printing area must be in accordance  
   with local Electrical Safety Regulation 
 
 
      1.5  Handling Precautions 

 
    1.5.1  Power Supply 

1. Install the printer near an easily accessible electrical outlet. 
2. Do not provide power to the printer through the same power line as for other noise 

generating devices such as motors. 

• Store ink and solvent in proper cabinet for flammable liquid storage. 
• Keep ink and solvent containers tightly closed at all times. If a container has 

sign of damage/leakage, fix or replace it immediately. 
• Clean ink or solvent spillages as soon as possible.  
• Only use dry powder, or carbon dioxide type of fire extinguishers. 

 

• If there’s no emergency power switch which can shut down all the power, do 
not connect the printer to main-power supply.  

• When the machine’s power is on, do not open the back cover of machine, or 
avoid touching electrical parts. 

• The printer or other equipments should be grounded, according to the local 
safety electrical connection regulation. The ground voltage should be less 
than 3 V. 

• Set the machine on smooth ceramic tile or cement ground  
• Use specified anti-static floor mat to minimize harmful static build-up. 

 

• Wear hand and foot safety protection gear when loading, unloading and 
handling media to avoid serious body injuries. 

• Use proper heavy duty handling equipment if available. 
 

http://www.floradigital.com


 
 
 
 

EC Vicente                                              Page 10                                         12Ｄec 2009                 
Copyright 2009 © Shenzhen Runtianzhi Image Technology, Co., Ltd.                                  http://www.floradigital.com                                            
 

 

3. Use a power supply matched with the printer specification. 
4. Connect the power cable directly to an electrical outlet. Do not plug several devices into 

one electrical outlet. 
 
 1.5.2  Printer 

1. Do not place anything on top of the printer. 
2. Do not rest you elbows on the printer. 
3. Open and close the top cover gently from the front of the printer with both hands. 
4. Before connecting or disconnecting the interface connector, turn the printer OFF. 
5. Do not clean the surface of the cover with benzene or paint thinner. The coating may 

come off or deteriorate. Wipe the cover with a soft cloth, if the cover is very dirty, use a 
cloth moistened with a neutral detergent. 

6. Do not touch the ink jet head surface. 
 

 
1.6  Regular Inspection and Maintenance 

The following regular inspection and maintenance must be performed in terms of 
characteristics of the UV-curable ink; 

1. Clean the carriage unit and the flat table conveyor surface everyday. 
2. Make sure that the carriage covers are always replaced. 
3. Perform ink supply circuit and print head cleaning when leaving the printer for a long 

time (2 weeks or more with no power). 
4. Perform head cleaning after leaving the printer idle for a long time. 
5. Shut off the UV lamp whenever the printer is not in use. 

 
 
1.7 Consumables 
 

1. Always use the recommended consumables (printing media, ink, ink filters). Failure to 
follow this instruction may cause poor printing quality and breakdown. 

2. Do not use ink past the expiration date as this may cause a print head breakdown and 
poor printing quality. 

3. Put a used ink bottle into a plastic bag and dispose of it as an industrial waste. Observe 
local regulations for disposal of waster ink bottles. 

4. Avoid spilling ink into your skin or clothes. Wash any ink off immediately with soapy 
water. 

5. Check the waste ink container everyday so as not to permit waste ink to leak from you 
printer. 

6. If the waste ink container is being installed or removed, spread a stain preventing sheet 
so as not to stain the floor with spilled ink. 

7. Store ink in a dark and cool place. Never store the ink in high temperatures or direct 
sunlight, doing so may cause the ink to deteriorate. 
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Chapter 2  - Basic Operation 
 
 
2.1   Getting Started 

This section provides the necessary information to operate the printer. Familiarize yourself 
with the basic of the printer before reading Section 2. 

 
Contents of this section; 

− Operating conditions 
− Consumables 
− External Views, Part Names and Functions 

 
 
2.2  Operating Conditions 
  This section describes the operating conditions for the printer. 
 
 
2.3  Installation Space 

There must be sufficient space around the printer for the replacement of frequently used 
parts, for the output of the printed media and for ventilation. In addition, maintenance space, shown 
below, is required to repair the printer or replace components. 

 
 
2.4  Environment Conditions 

 
2.4.1  Operating temperature and humidity levels 

The printer should be used within the temperature and humidity ranges as shown below; 
Temperature : 20 C to 30 C 
Humidity : 30% to 70% 
Ø To obtain better print quality, use the printer within temperature of 20 C to 25 C. 
Ø When the operating temperature is lower than 20 C or higher than 40 C, print  

speed is reduced to two-thirds of normal print speed to maintain good print 
quality. 

 
2.4.2  Places where the printer must not be installed 

       Do not install the printer in the following places: 
² A location near a fire 
² Places exposed to direct sunlight 
² Places subject to vibration 
² Places with excessive dust 
² Places subject to extreme changes in temperature or humidity 
² Places near an air conditioner or a heater 
² Places where the printer may get wet 
² Places near a diazo copier that may generate ammonia gas 
² Places with poor ventilation 
² Unstable places 
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2.5  Consumables 
 
 2.5.1  Available Media Types 
  The following types of media are available: 
  For details ask our sales office or a nearby agent. 

ü Paper 
ü Advertising banner 
ü PVC 
ü Mesh Fabrics 
ü Adhesive Vinyl 
ü Glass Sheets 
ü Ceramics 
ü Steel Sheets 
ü Acrylic Boards 
ü KT Boards 
ü PVC Boards 
ü Foam Boards 

 
 Note: Contact our service center for detail 
 
 

2.5.2  Precautions for storing media 
² Avoid direct sunlight and water both before and after opening the package. Put 

media in a box or envelope to prevent dust and store media in a cool, dry and dark 
place. 

² Avoid rapid change of temperature and humidity, and store media where 
condensation will not occur. 

² Do not store media standing on end to prevent disorder of media and damage to 
the edges. 

² Do not pile up media rolls. 
 
 

          2.5.3  Precautions for disposing of media 
² Dispose of media in accordance with local conditions and regulations. 

 
 

2.6  Precautions in use 
² Avoid change of temperature of humidity after opening the package. Set media in 

the printer after leaving media in the operating environment for 3 hours or more. 
Suppose change of humidity by turning the air conditioner on. 

² Due to media characteristics, curling of media in low humidity and wrinkling of 
media in high humidity may occur easily. Use media in a normal temperature and 
humidity environment (around 23C to 50%RH). 

² Do not use scratched, wrinkled, curled or dust-stained part of media. Especially, 
damaged edges (both edges) affect media feeding. Also, do not drop or wet the 
media. Doing so may adversely affect printing quality and cause malfunctioning. 

² Hold margins of the media so as not to touch the print surface. Adhesion of 
sebaceous matter or sweat may adversely affect printing quality. 

² Roll media correctly before setting in the printer. 
 

http://www.floradigital.com
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2.7 Precautions for handling prints 
² Do not touch the print surface before the ink is completely cured by the UV lamp. 
² Hold margins of the media for handling 
² Especially use care within 24 hours after printing 
² Rubbing of the print surface causes color fading or color transfer 
² Do not superimpose print surface to prevent color transfer. 
² Do not superimpose on copy prints or laser prints to prevent sticking due to ink or 

toner. 
² Do not rub, scratch or hold the media to prevent peeling. 
² Do not rub or leave the media in wet condition to prevent blurring. 

 
 
2.8  Other precautions 

² Aging of media causes color fading and a change in quality 
² Check media condition and use well-conditioned media. 
² Media dust due to cutting may cause floating of laminated coating. 
² When using media with glue, adhesive matter (glue) may stick to the platen. In this 

case, wipe up adhesive matter. 
² Sticking of adhesive matter may cause paper jamming. 

 
 
 
2.9  External Views, Part Names and Functions 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.9.1 Operation Panel 
The operation panel serves as the interface between the machine and the operator. 

The machine is set online or off line through the on line/off line button. Once the machine is 
offline from the computer, the movement of the machine can be operated from the operation 
panel. The UV lamp can be turned on or off from the the operational panel. 

Start Button 

Emergency 
Stop Button 

Computer Monitor 
Control Panel 

Electrical 
Control Panel 

Front Protective Cover 
Maintenance 
Compartment 

Front Extension 
Table 

Take up Roller 

Y-Feed Servo Motor 
Compartment 

Ink Bottle 
Compartment 

Front View of F1-250UV 

Computer 
Compartment 
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2.9.2  Computer Monitor 
  14” LCD monitor 
 
2.9.3  Emergency Stop Button 

The emergency stop button is placed on top of the side covers for both the left and 
the right cases. Once it is depressed, electrical power for the printer controls is cut-off. 

 
2.9.4  Start Button 

The start button is placed on the right side cover accessible to the operator. If the 
emergency stop button is released, pressing the start button will restore electrical power to 
the printer.  

 
2.9.5  Y-feed motor compartment 

The Y-feed motor compartment also serves as a hold for the computer keyboard and 
mouse. It is housing the Y-feed or conveyor servo motor and assembly. 

 
2.9.6  Computer Compartment 

The computer compartment is used to hold the computer which controls the printer. 
 
2.9.7  Electrical Control Panel 

  The electrical control panel contains the servo motor driver both for the y-feed motor 
and carriage motor. Likewise the driver pack for the take up and feed rollers are also 
mounted on the electrical control panel. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.9.8 Front Protective Cover 

It serves as a mechanical shield against stray UV light that could harm the operator's 
eyes and skin. 

 
 
2.9.10 Maintenance Compartment 

It is also called left case, where the home position for carriage, ink purging, ink 
priming and print head suction cleaning is done. By opening the maintenance compartment 
door, the carriage assembly is exposed to the operator. 

 

 

Electrical Control Chamber 

Printhead 
suction 
pump 

Media 
suction 
pump UV power 

supply 

Servo 
Driver 
supply 
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2.9.11  Feeding/Take up System 
This system is applicable to roll to roll printing mode only. The tension of the roll-to-

roll media depends on roller torque settings. The roller torque is adjustable; turning the 
torque knob clockwise will increase the torque. The roller locking mechanism must be locked 
when printing to avoid slippage of media. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.9.12  Front Extension Table 

It holds/support the printed rigid media in flat position after printing. It could hold up 
to 500 Kg of rigid media. 

 
2.9.13  Ink Bottle Compartment 

It serves as a compartment for ink and waste bottles. 
 
2.9.14  Ink Supply Control Compartment 

 It is located on the side of the ink bottles compartment. The buzzer, negative pressure air 
pump and the corresponding ink supply pumps are mounted on the ink supply control 
compartment. 

 
2.9.15 Rear Extension Table 

  This serves as a support for the rigid media being feed into the conveyor belt of the 
printer. The rear extension table could hold up 500 Kg of rigid media. 

 
 
2.9.16  Power Supply Control Panel 
  The main power circuit breakers are found on the power supply control panel. 
 
 
 
 
 
 
 
 
 
 
 

 
Media Feeding/Take-Up Roller 

Roller 
Lock 

Torque 
knob 

Roller 
Lock 

Main Circuit 
Breaker 

Power 
Cables 

 

Main Circuit 
Breaker 

DC Power 
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2.9.17  Media Positioning Bar Lever 
 This serves as the actuator to move the media positioning bar in position during 
alignment of the rigid media when placed on the feed conveyor. Press the lock and pull the 
lever to position the media guide, press and push after the media was placed on the 
conveyor belt ready for printing. This is applicable to rigid media board only. 

 
 
 
 
 
 
 
 
 
 
 

 
2.9.18  Vacuum Chamber Adjustment Lever 

  The flat bed is divided into eight (8) vacuum chambers. Vacuum area could be 
adjusted according to the media size. Vacuum chamber adjustment lever if fully retract, only 
the vacuum chamber 1 and 2 are working, otherwise if pulled fully all vacuum chambers are 
working. 

 
 
 
 
 
 
 
 
 
 
 
 
 
2.9.19  The Control Panel 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Lever lock 

Conveyor Belt 

Media Positioning Guide 

Media positioning 
bar lever 

Conveyor Vacuum Bed 
 

1 
2 

3 4 
5 6 

7 8 Note:  
If this lever is fully pulled 
all vacuum chamber are 
working. 

 
Vacuum Chamber 

Control Lever 

8 
vacuum 
chamber

s 

Figure 2 – Control Panel 
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2.10.0  On line/Off line Button 
This button will set the printer to be connected or disconnected with the computer. 

Push to set on line and push again to set off line. If the machine is off line the button lamp is 
turned on while it is turned off otherwise. 

 
2.10.1  Maintenance Button 

The carriage head will start automatic print head nozzle clean up procedure. It will 
purge ink to the print head to refresh the nozzles and perform suction cleaning. 

 
2.10.2 Left Button 

This button if the printer is set offline will move the carriage to the left. 
 
2.10.3 Right Button 

This button if the printer is set offline will move the carriage to the right. 
 
2.10.4 Forward Button 

Pressing this button will make the conveyor advance towards the operator. 
 
2.10.5  Backward Button 

Pressing this button will make the conveyor away from the operator. 
 
2.10.6  UV Buttons 

The UV Buttons will turn on/off the UV lamps. UV1 Buttons controls the left UV lamp 
while the UV2 controls the right UV lamp. 

 
 

2.11  Maintenance Section 
 

2.11.1  Print Head Carriage Assembly 
The print head carriage assembly houses the print heads, secondary ink tanks, print 

head control board, raster reader, negative pressure sensor, carriage height adjustment 
motor and the two UV lamps. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Carriage 
Cover 

Printhead 
Control Board 

Negative Pressure 
Sensor Display 

Secondary 
Ink Tanks Right UV 

Lamp 

Left UV 
Lamp 

Printhead Carriage Assembly 

Vacuum shut-off valves 
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2.11.2  Automatic Capper and Suction Assembly 
  The automatic capper sits below the print head carriage assembly. The capper 
moves during performance of print head maintenance. It moves to close the gap between 
the capper surface and the print head before suction and returns back after the cleaning 
process is finished. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.11.3  Negative Pressure System 

  The negative pressure system is used to hold the ink and preventing it to drop. The 
negative pressure can be adjusted thru its regulator. Turn clockwise to increase the vacuum 
and turn counter clockwise otherwise. Negative Pressure Shut off/on valves are provided at 
the back and front of the carriage to keep the negative into the system when the power is 
shut-off. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Negative 
Pressure 
Regulator 

Negative Pressure Regulator 

Optional 
feature 

 
Front of Carriage 

 
Negative Pressure 
Shut off/on Valve 

Note: 
The arrow heads indicate the 

movement of carriage and the 
Printhead auto-suction Assemblies. 

 
Maintenance Station 

Carriage 
Assembly 

Printhead 
Auto-Suction 

Assembly 

Auto media height 
detection mechanism 

Back of Carriage  
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2.11.4  Manual White Color Recirculation Switch 
  This switch is used to run the white ink recirculation pump manually. It is used to 
prevent the settling of the white ink pigment on the bottom of the ink bottle. Optional feature 
for this machine. 

 
2.11.5  Ink Prime/Purge Switch 
  The ink prime or purge switch is used to activate ink priming. 

 
 
 
 
 
 
 
 
 
 
 
 

2.11.6 Auto Detect Media Thickness System 
      This mechanism will perform media thickness check every time you send an image 

for printing. A message will pop as shown below, the first window will ask you if you want to 
adjust the carriage height. The second window will pop out if you click YES and ask you 
how much you want the height to be set.  

You must click the modify button every time you made changes otherwise the 
change will not be updated and click close to continue printing. Clicking No or Stop Print 
button will just simply send the carriage to start printing directly. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5 – Ink Prime and White Ink    
       Recirculation Switch 

Ink Prime 
Toggle switch 

White re-circulating 
Toggle switch 

  

1.0 

Encode here the 
height you want 

 
Media Height Detector Assembly Carriage Assembly 
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2.12  Starting the printer 
1. Make sure there is no media or materials on top of conveyor belt specifically along the path 

of carriage during printing. 
2. Plug the machine power cord to the electrical power source outlet. 
3. Check and reset all emergency stop buttons. 
4. Turn on the circuit breaker, leaving the breaker for the vacuum pump turned off. 
5. Turn on the computer and plug the Dongle if necessary. 
6. Press the machine start button. 
7. Open the maintenance compartment door to show the print head carriage status. 
8. Open the negative pressure shut-off valves both at the front and back. 
9. Activate the ink prime toggle switch. 
10. Press the on line/off line button on the control panel to disconnect the machine from PC. 
11. Press maintenance button, this will automatically start the suction cleaning of the print heads. 
12. Test the movement of the printer by moving the carriage using the operation panel. Left, right, 

forward and backward, to check mechanical functionality. 
13. When everything is verified to be functional, set the printer to on line by pressing the on 

line/off line button. 
14. Open the Photoprint software and machine is ready for operation. 
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Chapter 3  - Working System of Flora F1 250UV 
 
 
 
3.1  Brief Introduction 

The Flora F1-250UV large format printer is using raster image technology to process photos 
stored in computer. It is one of the most innovative products, which combines photo digital 
technology with high precision engine driver. It produces super wide printouts for business use. 

It is a high technology equipment with a user friendly operating system with simple 
operational and maintenance procedures. Though simple, it is composed of several precise systems. 
In this chapter, we will introduce the system components and operator guide. 

 
 
3.2 Konica Minolta Print head Assembly 

  In a high quality and high performance configuration, Konica Print head offers a high-
resolution, high-speed and compact inkjet print head lineup suitable for both wide format and industrial 
applications. 

  
  Konica Minolta print heads are based on piezo-electric materials (PZT), in which can be 
made to move by applying an electric field across it. Ink channels composed of piezo walls can eject 
small drops of ink in accordance with the electrical signals applied to the electrodes on the walls.  

  
  The KM512 Print Head is driven by “shear mode”, in which the walls bend inward and 
outward to generate a pressure wave inside the channel. This mechanical ejection principle allows a 
wide range of inks including oil and solvents, which is a great advantage when compared with the 
thermal ejection inkjet head.  

  
  This section introduces the KM512 Print Head technologies. 
 
 
 
Main Features: 

Technology Piezo Drop On Demand (Shared Wall 3 
Cycle) 

Number of Nozzles 512 Nozzles (256 nozzles x 2 rows) 

Resolution 360 dpi 

Nozzle Spacing 70.5um pitch (141 um pitch×2 rows) 

Maximum 
Frequency 

12.8 kHz 

Drop Volume/Size 14 pL 

Drop Speed 6 ± 0.5 m/s 

Printing Width 36.03 mm 

Heater 
Temperature 

Under 55º Celsius 

 
 Table 1 – Features of Konica Minolta Print head 

Konica Minolta Print head Dimensions 
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3.3  Print Head Connector Board  (PN: 116-0381-010) 
 This board is used as interface board for Printhead and the Printhead Control Board thru a 30-pin 
flexible data cable.  
 
 
 
 
 
 
 
 

Drive Board 

Head Chip 

Manifold 

Left Side Right Side 

Nozzle Plate 

Ink Jet 

Thermistor 

Heater 

Parts of the Konica Minolta Printhead 

Print Head Connector Board 
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3.4  Servo Driver Board 
 The Servo Driver Board serves as the movement control board and ink control board packed into 
one circuit board. 
 Power to the corresponding ink pumps are sent by the Servo Driver Board as well as the control 
signals from the secondary ink tank level sensors are being received and processed. This binary information 
about the status are being processed accordingly in order to provide the power to turn on the ink pumps to fill 
in the secondary ink tanks. 
 The control for the automatic carriage height adjustment is also handled by the servo driver board as 
well as the UV status and the x-axis limit sensors. The controls for the ink prime and printhead cleaning are 
also handled by this board. The inputs from the status of the switch on the operational panel are being 
received and processed by this board. The connectors J15, JP1, JP2 and JP5 are not use. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.5  Printhead Control Board  (PN: 116-0386-021) 

The image data is fetched by the Print Head Control Board from the USB_IF buffer through 
the Image Data Cable (UCBJ10PHBJP1) and 100-pin JP1 AMP connector. The image is then 
processed by the image data processor and dispatch to the print heads. The printheads fires the ink 
depending on the binary status read by the Raster Reader which is sent to the print head control 
board. 

Likewise, the print head heating control is also integrated into the Print Head Control Board. 
Thus, the print head temperature can be accessed from the Floraprint driver graphical user interface 
or GUI.  

J1 connects to the AC power source for the print head heating current source. The carriage 
displacement pulse signal is sent from the encoder reader to the print head control board through 
PHBJ9ENR1 into J9 D-sub connector. 

The secondary ink tank level sensor signal from the secondary ink tanks pass through cable 
J2 and into the J2 connector of the print head control board. If the secondary ink tanks are full, 
corresponding LED indicators will turn on near the J4 connector. The binary status for the secondary 
ink tank level is then sent to the Servo Driver Board through cable SCBJ7PHBJ7. It is then 
processed on the Servo Control Board to activate the ink pump motors. 

 

J6 from Power 
Supply (24Vdc) 

J4 to Automatic 
Carriage Height 

Adjustment 

J7 to Ink Level 
Sensor from 

PHCB 

J1 to Operation Panel PCB 
J3 to Capper Control 

J14 to Ink 
Pumps 

J13 to Ink Priming 
Control/Buzzer 

J11 to Control 
Panel PCB  

J5 To USB_IF 
Board 

J8 to Limit 
Switches 

 J2 to UV 
Remote Port 

The Servo Driver Control Board 

Status Code 
Display 

J9 No Use 
J12 to Ink 

level sensor 

J10 No Use 
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The shutters of the UV lamps were also controlled from the Print Head Control Board. For 
both the UV lamps shutter control they are both connected through J5. The Print heads are 
connected to the Print Head Control Board by connectors JB1 to JB16.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.6  USB Interface Board  (PN: 116-0336-072) 

 The USB board is the main interface of the machine to PC. The image data and control 
information are transmitted from the PC USB port to the USB port of this board. The 
communication and image data transfer are conveyed through the 100-pin data cable.  
 For this particular printer model, the USB board is also used to communicate with and 
control the servo driver control board. 

There is a separate control circuitry designed to control the x-axis and y-axis movement. It 
conveys a signal for the servomotor step and direction; and hence, the servo driver can be able to 
drive the servo system mechanism. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

100-pin Data Cable 
to Print Head 
Control Board 

To USB 2.0 
port of Host 
Computer 

J1 To Power 
Supply (5Vdc) 

J5 to Servo Driver 
Control Board J4 To X-Axis 

Servo Motor 
J3 To Y-Axis 
Servo Motor 

LED Status 
Indicators 

Connection Information for the USB Interface Board 

JP1 No Use 

J11 No Use 

J2 No Use 

P1 J10 
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J12, J6,J7, J8 
J9, JP5, JP6 

Jumper; 
S1 = 1&2 
S2 = 1&2 
S3 = 1&2 

J5 UV Lamp 
Shutter Control 

J6 to Raster 
strip reader 

J7 to Servo 
Control 
Board 

J4 To Negative 
Pressure Sensor  J2 to ink level sensors 

JP1 To USB_IF 
Board 

J1 to Power 
Source 

(15/24 Vdc) 
K2 
K1 

C1 
K3 

C3 
C2 

M2 
M1 

Y1 
M3 

Y3 

Y2 

W2 
W1 W3 

Print head Control Board with connection for 15-heads configuration 

J3 No Use 

No Use: 
      JP2, JP3   

    and JP4 
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3.7  X-axis and Y-axis Servo Driver Pack 
  The movements of the Carriage and conveyor belt Servomotors are controlled by their respective 
Servo Driver. This servo motors are basically two-phase, reversible, induction motors modified for servo 
operation and used in applications requiring rapid and accurate response characteristics. To achieve these 
characteristics, this ac servo motors have small diameter, high resistance rotors. The ac servo motor's small 
diameter provides low inertia for fast starts, stops, and reversals. High resistance provides nearly linear 
speed-torque characteristics for accurate servo motor control 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.8  Automatic Carriage Height Adjustment System 

In order for the printer to print seamlessly on different kinds of media, the carriage height 
should adjust automatically to whatever media thickness it should print upon. For this specific printer 
model it is equipped with a carriage that could automatically adjust its height depending on the media 
thickness to be printed upon. The user can choose whether to print using the default carriage gap 
between media of 2.0 mm or opt to increase the gap up to 5mm. 

The assembly uses a solenoid activated mechanical touch sensor to sense the media height. 
This mechanical sensor protrudes downward from the carriage assembly during media height test. 
The system also uses a raster strip and encoder to determine the accurate height adjustment from 
default height settings. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Connection Information for Automatic Carriage Height Adjustment Stepper Motor 

Driver Signal from USB 
Interface Board 

From AC Servo 
Motor Encoder 

To AC Servo 
Motor 

From AC 
Power Source 

X-axis Servo 
Driver Pack Y-axis Servo 

Driver Pack 

Servo Driver Packs 

+5Vdc Pulse +5Vdc DIR +5Vdc 

GND +24Vdc A+ A- B+ B- 

To Stepper Motor 

ON 

OFF 

Driver Pack DIP-switch Setting 

1 2 3 4 5 6 7 8 
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3.9  Ink Control System 
The ink Bottle/Barrel serves as the main reservoir for ink supply, should be refilled in a timely 

manner so continuous supply of ink will not be interrupted during printing. The level of ink inside the 
bottle/barrel can be monitored visually or using the buzzer system. Refilling is done manually. 

The ink pumps suck and discharge the ink into the secondary ink tank. A five-micron filter is 
being provided to prevent the secondary tank from being contaminated by unwanted particles, which 
are inherent in the ink. Ink level sensor inside the secondary ink tank sends an open or close contact 
signal to the Print head control board and Ink control board to control the operation of the pumps. An 
optional micro filter is added to enhance the filtering of ink before it flows into the print heads. 

Every time the print heads eject/fire ink droplets, the ink flows and fills the space left by 
droplets. A negative pressure system is responsible for holding the ink from flowing out of the print 
head nozzles. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.10  Negative Pressure System 

Negative pressure system is used to hold the ink from dripping out of the print head nozzles. 
Pressure settings vary on every machine. The recommended setting range is from -2.4 to -2.6Kpa. 
Too low negative pressure setting will result to ink dripping or print head cannot jet ink. Too high 
negative pressure setting will cause ink starving over time and ink overflow in the negative pressure 
line system.  

 
 
 
 
 
 
 

Ink Control System 

Ink Barrel 

Printhead 

Last Chance 
Filter 

Secondary 
Ink Tank 

Ink Filter 
(Barrel Type) 

Printhead 
Control Board 

Servo Driver 
Control Board 

M Ink Pump 

Ink Level 
Sensor Negative 
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Pump 

Negative Pressure Digital Sensor Display 

Note:  
Push the arrow up and arrow down 
buttons simultaneously to reset the 
negative pressure to zero. 
 
Please refer to negative pressure setting 
parameters for further details. 
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3.11  Ink Protect Tank  

This tank serves as the ink overflow protection for the vacuum line system. If overflow 
happens, the ink will flow into this tank, once the ink reaches the maximum level, the sensor will shut 
off the print head control board. Without the ink protect tank, the vacuum system will fail to function if 
the tubes are filled with overflowed ink. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.12  Limit Switches 

There are three (3) limit switches used on this printer. Two of which are installed at the left 
end of the rail at carriage or home position. The left most serves as overrun limit switch for carriage 
left stroke and the inner side serves as the home position switch. The third is installed at the right 
most end of the rail serves as the over run limit switch for carriage right stroke. 

 
 
 
 
 
 
 
 
 
 
 
3.13  Raster Encoder and Raster Ruler 

The Raster Ruler is a lined semi transparent plastic strip installed on the carriage rail. The 
raster encoder is responsible for reading the lines across the strip length, then generate pulses that 
will be sent to the Print head to fire the ink droplets. 

 
 
 
 
 
 
 
 

The X-axis Limit Switches 

Raster Encoder Raster Encoder Setup 

The Ink Protect tank 

Drain port 

Note:  
When resetting the negative pressure to 
zero, you should open the tube connector 
cap. After the negative pressure is reset 
replace and tightened cap properly. 

cap Overflow 
tank 
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3.14  Power Supply Modules 
 There are two power supply modules which are AC-DC converters used in this printer. One outputs 
15Vdc and the other is 24Vdc. These modules give out all the necessary supply voltages to power all the 
electronic boards on this printer. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.15  AC Noise Filter 

The AC noise filter comes standard with the printer. It is used to filter spikes in the incoming 
electric power. It is located in the electrical control panel. 

 
 
 
 
 
 
 
 
 
 
3.16  Media Rollers and Torque Motors 

The media rollers torque control the tension of roll-to-roll media and the torque can be 
adjusted thru the torque Knob, turning the knob clockwise will increase the torque of media roller. 
The voltage control module regulates the voltage for the roller torque motor. 

 
 
 
 
 
 
 

Power Supply 
Module 2 – 350W 

15VDC 

Power Supply Module 
1 – 350W 24VDC 

The Power Supply Modules 

The AC Line Filter 

 
Media Roller Torque Motor 

Motor 

Motor 
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Chapter 4 - Setting Up The Printer 
 
 
 
 

4.1 Brief Introduction 
 This is to describe the proper procedure in unpacking and setting-up the machine.  
 

 
4.2  Wooden Crate Proper Handling 
             The F1-250UV printer is packed inside a W100 x L330 x H160 cm wooden crate.  

Ø Check the condition of the crate prior to unloading it out of the container van.  
Ø Take some digital photos in case there are some traces of damages on the crate due to 

mishandling for future reference or other purposes.  
Ø Please pay attention when using fork lift, there are label signs on some portion of the crate that 

prohibits the use of forklift.  
Ø Bring the crate to the unpacking area where there is enough space to move around when opening 

the crate. Minimum unpacking area is 3m x 5m. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
4.3 Unpacking the Machine 

The unpacking area should have a leveled floor strong enough to support the machine weight. 
Never try to open the crate at elevated platform or inclined floor. At least two persons are needed to do 
the uncrating activities below. 
 
² Start removing the bolts and nuts from the crate top cover. 
 

Wooden Crate Labels 
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² Bring down the top cover on the floor and put away from the working area so that you can 

move around freely and safely during unpacking. 
² Remove the front cover of the crate by removing all the bolts and nuts around this cover. Be 

careful in opening the front cover as the spare parts and other machine accessories inside the 
crate might have moved or disoriented during the transit of the package. Put away the front 
crate cover. 

² Remove the side cover by removing the bolts and nuts and keep away from the unpacking 
area. 

² Take and separate the machine accessories, spare parts and inks from the machine to give 
more space in moving the machine off the platen. Check all the items against the packing list 
provided.  

² Remove the nuts from the bracket that hold the machine base from the platen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
² Use forklift or other handling equipment to unload the machine from the platen. Make sure 

weight is balance on each side of the machine when using the forklift. 
 
 
 
 
 
 
 
 
 
 

 

 

Machine is fixed with holding fixture 

Lifting-up the machine using forklift 
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² Open and remove the anti-static cover and air bubble pack from the machine.                                    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
               
 
 

4.4  Receiving Report 
In case there are discrepancies noted between the actual parts received and packing list, it 

should be reported to our nearest representative. This report includes defective, deformed or missing 
parts, damaged due to mishandling, wrong delivered parts, etc. 

 
 
 
 
 
 
 
 
 
 
 
4.5  Pre-Installation Requirement 

Ø The minimum working area should be 570 cm x 220 cm, this includes the space for the 
operator to move around the machine conveniently and safely. 

Ø Provide vertical clearance of at least 50cm above the top surface of the machine body, for 
top cover opening clearance. 

Ø Prepare the necessary AC plug on the power cord attached to the machine. Please see the 
Technical Specification table for the power requirements. 

Ø If the PC is not supplied with the machine, customer must meet the minimum PC 
specification requirement to be used in this machine 
ü Pentium 4 1.0 GHz, 1Gb RAM, 80GB Hard Disk memory 
ü At least 4x CD-ROM or DVD Drive,  
ü USB Port for Hardware Key 
ü Windows XP Professional Service Pack 2 
ü LCD monitor   

Ø Safety signs must be available within the working area. 
Ø Exhaust System must be provided for the solvent and Ink fumes. Please note that fumes 

are heavier than air so it is most likely the concentration happens at the lower level of the 
room. 

Ø Lightings should be sufficient enough. 
Ø Storage Cabinet for the Ink and Solvent stock is highly recommended to secure them very 

well. 
 

Machine covered with Anti-static sheet Machine Covered with bubble pack 
 

 

Spare parts 
Packing list Spare 

parts box 

Spare parts and packing list 
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Ø Waste Container should be available for ink and solvent waste as well as ink/solvent 
contaminated cloth inside the Printing area. 

Ø Waste disposal should be in accordance with your local laws governing Hazardous Waste 
Disposal. 

 
4.6 Machine Pre-Installation 

        Once the machine is placed and all spare parts are thoroughly checked, start doing the 
following pre-installation activities; 
²  Install the automatic Feeding and Take-up Rollers if applicable.  
²  Removed the Tie Wires which hold the Print head Carriage from moving. 
²  Check the height of the Print head Carriage over the printing platform. The height should be at      

least 2mm above the media printing surface.  
²  Check the movement of the Print head Carriage for any obstruction by moving it manually from   

one side to the other end. 
²  Prepare the necessary power source for the machine. 
²  Install the LCD Panel / Monitor and the PC, keyboard and mouse to be used on this machine. 
²  Place the CPU to the computer compartment on the right side of the machine. 

 
4.7 Software Installation Procedure 
 

 4.7.1  PhotoPrint 5 Installation 
Ø Turn-on the Power for PC and Monitor.  
Ø Insert the CD supplied with the machine with label PhotoPrint FloraPrint Edition 5.0v3 for 

the necessary installation. 
Ø The screen will prompt you with starting InstallShield Wizard…, then Choose Setup 

language window. Select which language you will use. Then click Next. 
 

 
 
 
 
 
 
 
 
 

 
Ø The Application Installer Setup will now prepare the InstallShield for the setup process and it 

will prompt you later to enter your user number and password of the Hardware Key (Dongle 
Key). The user number and password can be found on the Hardware Key. Click Next. 
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Ø Click Next when Software to Install  and the Welcome screen window shows up.  
 
 
 
 
 
 
 
 
 
 

Ø Click Yes to view the Readme file. The Readme file contains the last-minute issues and 
information that are not included in this documentation.  

   
Ø Read the Software License Agreement  Select “I accept the terms of the license 

agreement” and click Next  to accept.  
 
 
 
 
 
 
 
 
 
 

Ø Click Next when Select Features and Select Program Folder window comes in.  
 
 
 
 
 
 
 
 
 
 

Ø Install to desktop check box must be checked and then click next. 
 
 
 
 
 
 
 

Check 
this box 
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Ø Click “Next” on the Start Copying Files window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ø Click “Finish” after successfully completing the software installation. Then remove the 
installation CD. 

 
                             
 

 
 
 

      
 
 

 
 

 
4.7.2 Flora Printer Driver Installation 

Ø Insert the CD supplied with the machine with label Flora Print-driver CD-V2.0 
into the DVD ROM. 

Ø Copy the driver software from the CD installer to desktop or any other local 
drive. The filename should PD_2515KMUV.exe 

Ø Double-click the installation program. The installer package will be extracted 
and once it finished extracting the setup files, the operator will be prompted to 
select the installation language. After selecting the preferred language, click 
“OK”. 
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Ø The installer will prepare the InstallShield Wizard. Click “Next”. 

 
 

 
 
 
 
 
                  

 
 
 
 
 

Ø Select the printer model to install. Click “Next” to continue.  
 

 

                  
 
 
 
 
 
 
 
 

 
 
Ø Select the destination folder and click “Next”. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Ø As soon as the installer finished copying the necessary files, the Wizard complete 
dialog box will show, select “Yes, I want to restart my computer now.” and click 
“Finish”. The computer will restart and your installation of the driver is complete. 
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4.7.3  Adding Printer on the device setup 
 

Ø Double click the Photo Print server Icon on the Desktop to open the PhotoPrint Server 
FloraPrint Edition. From “Setup” Menu, select and click “Add Setup”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ø Select the appropriate printer model and click “Next” to continue. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Double click 
this Icon 
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Ø  “Remove the tick on the “Install desktop driver for this printer” tick box and click 
“Next” to continue. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ø Click “Finish” button on the window to completer the add setup process. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ø If the setup is successful the installed device or printer will be shown on the Photoprint 
GUI. 

 
 

                 
 
 
  
 
 
 

         
 
 
 
 
 
 
 
 

Uncheck 
this box 
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           4.7.4  Testing the Printer Functions through PC 
                 This is to check the mechanical functionality of the Printer through PC.  
 

Ø Using the RTZ Driver software, move the Print head Carriage from left to right, then to 
home position. Check also if the Y-axis Servo Motor is also working by moving the 
forward and backward button by clicking the appropriate arrow head below. 

 
 
 
 
 

Ø Once all the printer functions are working normally, shut-off the printer power. 
 
 
     4.7.5  Printhead Installation Procedure 

Ø Unpacking the Print head 
² Open the package, and then take out the anti plastic bag. 
² Open the anti-static plastic bag and remove the head. 
² Remove the head cap.                     

 
 
 
 
 
 
 
 
 

Note: 
 The head is pre-loaded with ink analog to prevent drying of the nozzles during 

transportation.    
 The head is also equipped with a cap to protect the nozzle surface and prevent 

drying of the ink analog. 
 

Ø Hold the middle of both sides of the cap squeeze and twist the cap to release the 
latch that holds the head as shown below. 

 
           

 
 
 
                                 

                                  
 
 
 
 
 

  
 

  
The serial number 

should match 

How to remove cap 

Printhead 
Cap 

 Press here 
 

How to unlock the Latch cap 

Latch is 
released 

Press here 
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Ø Take note each printhead must have input and bleeding tubing. The input tubing 
must be connected to the right port with disc 20µm ink filter. While the bleeding 
tubing should be connected on the left port and must be closed using a connector 
tube connector cap. See photo below. 

 
 
 
 
 
 
 
 
 
 
 

 
 

Ø Take-out the printhead fixation screws from the carriage printhead mounting plate. 
See those pointed by arrow heads below. 
 
 
 

 
 
 
 
 
 
 

 
Ø Install the print head one by one and slightly tighten the fixation screws enough 

for the printhead to move when doing the mechanical alignment (Y-align). Please 
take note of proper printhead orientation. See photo below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

20µm 
ink filter 

Inlet 
tubing 

Tube Connector 
cap  Ink bleeding 

tubing 

 

Inlet port Ink bleeding 
port 

Latch 

 
10 Printhead Installed on Carriage Printhead Orientation 

Front fixation 
screw must 
be tightened 

Back Fixation screw 
slightly tight 

Mechanical 
alignment screw  
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Ø Connect the input tubing of printhead to the Ink tank supply port accordingly as 
shown below.        

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ø Connect the 30pins flexible print head data cable on each print head and to the 
Print head Control Board. Please take note of the proper connection of cable. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ø Check all the connection again to ensure there are no misconnections and loose 
connections on the data cables. Power on the machine and check for any 
functional abnormalities on the carriage.  

 
 
4.8  Ink and Solvent Preparation 
 

² Pour the ink and solvent in their corresponding ink/solvent barrels. Be sure to observe 
proper procedure in handling the ink. See Chemical Safety Information. 

² Switch on the printer power.  
² Connect the ink pumps one at a time and check for any leakage along the solvent and 

ink line system.  

Printhead 
input tubing 

 
All Printheads input tubing connected to Ink tank 

Ink bleed 
tubing 

 

Ink disc 
filter 

Ink Tank 
supply tubing 

 

 
Male connector 

Slot 

Guide Female connector 

Proper Connection of Flat Data Cable 

Printhead 

 
Printhead Control Board 
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² Perform Ink Prime by activating the toggle switch. Do ink bleeding one printhead at 
time to remove air bubbles trapped inside the printhead. 

² Perform auto clean for printheads thru maintenance switch on the control panel or 
from the Flora driver GUI. 

² Send Test Printhead to see if all printheads prints a shown below;  
 

 
 
                                                                                    
 

  
 
 
               
 
 
 
 
 
 
 
    
 
  
 
 Note:  Above is an Illustration of Nozzle Test Print, only three colors are shown due to space  

constraint, Yellow and White printheads must print the same result. 
 
 
4.9  Print head Alignment  
 

 4.9.1  Brief Introduction 
 This is to describe the proper procedure in aligning the Print heads. 
 

 4.9.2  Printheads Mechanical Alignment (Y-Align) 
Ø On Flora driver GUI, click Test Print button and on the Test Printer tab select Y-

align then click “Test print” button. The result should look as shown below. 
 
 

 
 
 
 
 
 
 

Ø Noticed there are sets of horizontal lines for K1, K2 and K3. For the purpose of 
identifying sets of horizontal lines, K1 horizontal lines are colored pink, the K2 is 
black and K3 is blue though in actual print they are all printed black. 

 
K1 

K2 

K3 

C1 

C2 

C3 

M1 

M2 

M3 

Nozzle Test Print sample 

 

  

Select Y-Align 
Option Click to 

send print 

 

 

Select Test Print 
head Option 

Click to 
send print 
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Ø The first sets of horizontal lines is a K1 single broken line and K2 solid line, 
ignore the first 4 sets, select the rightmost set (with more horizontal lines) to get 
more accurate alignment. First you must align K1 to K2 then K2 to K3. The gap 
between K1 and K2 horizontal lines must be the same as the spacing between all 
K1 or K2 horizontal lines. Please see Illustrations below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ø Once K1, K2 and K3 printheads are aligned, tighten the two fixation screws 
properly. Do Y-align to other printheads in such a way C1, M1,Y1 and W1 will be 
aligned to K1, C2,M2,Y2,W2 and C3,m3,Y3, W3 to K2 and K3 respectively. 
Below shows how to do Y-alignment of the printheads. 

 
 
 
 
 
 
 
 
 
 

K1 

K2 

 
This gap should be the 
same as gap in K1, K2 

and K3. 

Gap K1 

K2 

K3 

Illustration sample how to Y align 
the K Printheads 

Gap K2 

Same gap 

K1 and K2 Y-align first set of Horizontal lines 
K1 K2 

This set of line is for info only 

Printed sample 
 

 
Printed sample 

 

Turn the mechanical alignment 
screw clockwise to pull the 

printhead forward and counter 
clockwise to push back. 

This screw must be tightened 
before doing the Y-alingment 

of printheads. 
These screws should be 

slightly tighten before doing the 
Y-alingment of printheads. 

Printhead 
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Ø Again due to space constraint not all print heads Y-align are shown above, 
however for those other printheads you can follow the same steps 

 
           Note :  Once the Y-alignment is completed, make sure you tighten the two fixation screws for 

each printhead. 
 

4.9.2  Printhead Internal Alignment 
Internal align is necessary for Konica heads because the Konica 512 head 

nozzles are made wherein the 512 nozzles are divided into 2 parallel rows of 256 
nozzles. Due to some uncontrollable manufacturing errors (tolerances) perfect 
alignment is not guaranteed. The printhead internal align is required for both printing 
directions; 

 
                  4.9.2.1  Internal Left Align 

Ø On the printer tab select Internal Left Align option then click send print as shown 
below. Further below shows how the print out should look like, the Illustration 
shows the C1 alignment happen at -1 (in-circled). 

 
 
 
 
 
 
 
 
 

Illustration for all printheads Y Align 

K3 C3 

K3 C3 

K3 C3 

K3 C3 

Y3 and 
C3 are 
aligned 

K2 M2 

K2 M2 

K2 M2 

K2 M2 

C2 and M2 
need to 

pull down 

K3 Y3 

K3 Y3 

K3 Y3 

K3 Y3 

K2 C2 

K2 C2 

K2 C2 

K2 C2 

K1 M1 
K1 M1 
K1 M1 
K1 M1 

K1 Y1 
K1 Y1 
K1 Y1 
K1 Y1 

M1 and Y1 
need to 
push up 

 

Internal Left Align 

-10 -9 -8 -7 -4 -2 -1 10 9 8 7 6 5 4 3 2 1 -5 -3 -6 C1 

L E F T 
-10 -9 -8 -7 -6 -5 -4 -3 -2 -1 10 9 8 7 6 5 4 3 2 1 C1 

Select Internal 
Left Align Option 

Click to 
send print 
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Ø On the Photoprint Job Properties click Driver Option >click advance button> 
offset button > tick the Internal of head and add the -1 mathematically on the 
Left table for C1 box as shown below. 

Ø You can also navigate thru Test Printer Tab by clicking the settings icon as 
shown in the lower left of Illustration. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

`     4.9.2.2  Internal Right Align 
Ø On the printer tab select Internal Right Align option then click send print 

as shown below. Further below shows how the print out should look like, 
the Illustration shows the M1 alignment happen at 2 (in-circled). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ø On the Photoprint Job Properties click Driver Option >click Advance button> 
Offset button > tick the Internal of Head and add the 2 mathematically on the 
Right table for M1 box as shown below. 

Ø You can also navigate thru Test Printer Tab by clicking the settings icon as 
shown in the lower left in Illustration below. 

 
 

Internal Right Align 

-1 -10 10 -9 9 -8 8 -7 7 -4 4 -2 2 1 -5 5 -3 3 -6 6 M1 

R I G H T 

-10 10 -9 9 -8 8 -7 7 -6 6 -5 5 -4 4 -3 3 -2 2 -1 1 M1 

 

Select Internal 
Right Align 

Option 
Click to 

send print 

After changing the offset value 

Tick internal 
of heads 

Default 
value for 
C1 is 0 

 
Click 

Settings 

 

-1  

Tick internal 
of heads 

New value 
for C1 is -1 
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Ø Follow the same steps when doing Internal of head alignment for other 
printheads not shown in the Illustration above. 

 
 

4.9.2.3 Printhead Left Align 
 

Ø On the printer tab select Left align option then click send print as shown below. 
Further below shows how the print out should look like. The Illustration shows 
the C1 alignment happen at -3 (in-circled). Please note that this time K1 is the 
reference printhead in aligning all other printheads.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ø On the Photoprint Job Properties click Driver Option >click Advance button> 
Offset button > tick the Between of Heads and add the -3 mathematically on the 
Left table for C1 box as shown below. 

Ø Basically the navigation is the same as the in Section 4.9.2.1 except for test 
option and parameter table. 

 

Left Align 

-10 -9 -8 -7 -4 -2 -1 10 9 8 7 6 5 4 3 2 1 -5 -3 -6 C1 

L E F T 
-10 -9 -8 -7 -6 -5 -4 -3 -2 -1 10 9 8 7 6 5 4 3 2 1 K1 

K1 is Reference 
Head 

 

 
Click Left 

Align Option 

Click to 
send print 

  

2  After changing the offset value 

Tick internal 
of heads 

Tick internal 
of heads 

New value 
for M1 is 2 

Default 
value for 
M1 is 0 

 
Click 

Settings 
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4.9.2.4  Printhead Right Align 
Ø On the printer tab select Right align option then click send print as shown below. 

Further below shows how the print out should look like, the Illustration shows 
the M2 alignment happen at 5 (in-circled).. Please note that this time K1 is the 
reference printhead in aligning all other printheads. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ø On the Photoprint Job Properties click Driver Option >click Advance button> 
Offset button > tick the Between of Heads and add the 5 mathematically on the 
Right table for M2 box as shown below. 

Ø Basically the navigation is the same as the in Section 4.9.2.1 except for test 
option and parameter table. 

 

K1 is Reference 
Head 

 

Right Align 

-1 -10 10 -9 9 -8 8 -7 7 -4 4 -2 2 1 -5 5 -3 3 -6 6 M2 

R I G H T 

-10 10 -9 9 -8 8 -7 7 -6 6 -5 5 -4 4 -3 3 -2 2 -1 1 K1 

 

Default 
value of 

C1 is -934 

Tick Between 
of heads 

 

 

-937 

Tick Between 
of heads 

 

New value 
for C1 is -937 

After changing the offset value 

 

Click Right 
Align Option 

Click to 
send print 
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4.9.2.5  Printhead X Align 
Ø On the printer tab select X Align option then click send print as shown below. 

Further below shows how the print out should look like, the Illustration shows the 
K3 alignment happen at 2 (in-circled). This time you align the left and right printing 
directions. 

 
 
  
 
 
 
 
 
 
 
 
 
 

Ø On the Photoprint Job Properties click Driver Option >click Advance button> 
click Motor button and add the 2 mathematically on the R_offset box as shown 
below. 

Ø Basically the navigation is the same as the in Section 4.9.2.1 except for test 
option and parameter table. 

 

X Align 

RIGHT 

-10 10 -9 9 -8 8 -7 7 -6 6 -5 5 4 3 -2 2 -1 1 K3
1 

-3 -4 

LEFT 
-1 -10 10 -9 -8 8 -7 7 4 -2 2 1 -5 5 3 -6 6 K3 9 -3 -4 

 
Click X Align 

Option 

Click to 
send print 

 

Default 
value of 

M2 is 2339 

Tick Between 
of heads 

 

 

-937 

2344 

Tick Between 
of heads 

 

New value for 
M2 is 2344 

After changing the offset value 
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4.9.2.6  Printhead Step Align 

Ø On the printer tab select Step Align option then click send print as shown below. 
Further below shows how the print out should look like. The Illustration shows 
three different scenarios.  

Ø The broken line was colored pink for the purpose of better understanding how this , 
the horizontal lines are printed black in actual output. When you do step align the 
first pass will print broken lines while the second pass will print the solid lines. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Figure 1 – Excessive Media Feeding Step 

 

 

Click Step 
Align Option 
 

Click to 
send print 

X Align 
 

Default 
value is 36 

Printing mode 
should be 

Bidirectional 

 

 
38 

 

New value 
is 38 

Printing mode 
should be 

Bidirectional 

After change the new value  
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Ø Figure 1 shows the motor step value when the test was sent is higher than exact 
value so we need to decrease, by trial and error method you can get the correct 
value.  

 
 
 
 
 
 
 
 
 

Ø Figure 2 shows the motor step value when the test was sent is lower than exact 
value so we need to increase, by trial and error method you can get the correct 
value.  

 
 
 
 
 
 
 
 
 
 

Ø Figure 3 shows the motor step has exact value so no need for any changes. To 
determine the exact motor step value setting, you need to bring the broken and 
solid lines closer until you can see one single line only.  

 
Ø Below is the table where you can find the Step Parameter setting.  

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2 – Insufficient Media Feeding Step 

Fig. 3 – Correct Media Feeding Step 

Motor Step Parameter Tab 
 

 

 

Change this 
number to get the 
exact motor step 

value 

Enlarged View 
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4.10  Printhead Voltage and Temperature Settings 
This section will describe the necessity to calibrate the Voltage and Temperature 

settings for each printhead. 
Ø By looking on the Left or Right Align printed samples in section 4.9.2.3 or section 

4.9.2.4 respectively you can determine what need to be done to get a better print 
quality. 

Ø First you need to see the magnified printed sample for each printhead. Lets take 
the illustration sample below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ø Assuming the green shaded area will be view over a magnifying lens at least 40X  
(100X magnification is better) the vertical lines are actually a group of dots pre arranged 

according to printhead nozzle design. For the case of Konica head it should look like 
below. 

 
                    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ø Sometimes getting the best dot print quality is a painful process so it needs patience. All 
you can do is play with temperature and voltage settings. 

 

Right Align 

-1 -10 10 -9 9 -8 8 -7 7 -4 4 -2 2 1 -5 5 -3 3 -6 6 M2 

R I G H T 

-10 10 -9 9 -8 8 
-7 7 -6 6 -5 5 -4 4 -3 3 -2 2 -1 1 K1 

Low Voltage or Low 
Temperature Settings 

GOOD High Voltage Setting 
or High Temp Settings 
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Ø The recommended Voltage setting range is controlled by Flora driver software so 
there’s no chance you set the voltage beyond the recommended range. While the 
recommended temperature setting is 40-45ºC in most cases ink manufacturers have 
their recommended temperature settings. 

 
Ø When changing the Voltage and Temperature settings click setting icon on the Test 

Printer tab or refer to section 4.9.2.1 how to navigate then click Voltage or Temperature 
button whatever is applicable.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note:  The actual reading for both Voltage and Temperature will appear only when the  
Read Button is click.  

 
Ø To change the temperature setting simply over write the existing value with your desired 

value then click Write button. While for Voltage you need to click the Set button to 
update the Voltage setting to your desired value. 

 
 
Ø Other factors than can influence print quality are; 

 Room Temperature 
 Humidity 
 Ink Viscosity 
 Negative Pressure Settings 
 Carriage Printing Speed 

 
 
 
 
 

Note:  
      In most difficult cases playing with Negative Pressure Setting and printing at slower 

speed can help improve the print quality significantly. 

 
 Voltage Window Tab 

Click this 
button to save 
the new value 

Click this button 
to display the 
current value 

 
Temperature Window Tab 

Click this button 
to display the 
actual temp 

Click this 
button to save 
the new value 
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Chapter 5  - Operation of the Machine 
 
 
 
5.0 Brief Introduction 

 This chapter introduces the details of operating the operating instructions of the machine 
from starting up to shutdown procedure.  
 

5.1 Starting-up Activities 
 It is highly recommended to do housekeeping before starting to operate the machine. 
Maintaining good housekeeping helps improve the quality of the output as well as the safety of 
operator. Below is the check list of activities that operator should do prior to operation of the machine. 
ü Turn on the ventilating and lighting system inside the printing room. 
ü Check and clear for any traces of ink spillage on the machine and the floor. 
ü Check if the Waste Ink Bottle is already full and replace if necessary 
ü Check if there is enough inks for printing and flush solution for cleaning the print head. 
ü Check and ensure that the printing platform along the print head carriage path is free from 

loose parts or obstructing object 
ü Removed the Print head Capping installed on the Printer Carriage 
ü Turn on the Main Power Switch and power-on the PC. 
ü Turn on the Printer Power 
ü Check the Negative Pressure setting 
ü Perform Solvent Flushing procedure on the Print head 
ü Perform Ink Priming procedure on the Print head 

 
5.2 Print head Jetting Check 
 Check the jetting status of each Print head periodically before, during and after using the  

machine. 
 
                          
             
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note:  Above Illustration show only three colors, yellow and white are excluded due to space 
constraint, please take note that all printheads must print the same. 

K1 

K2 

K3 

C1 

C2 

C3 

M1 

M2 

M3 

Click this to send 
test print head 

Select Test 
Print Head 
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5.3 Working on PhotoPrint Flora Edition Software 
 

Basic Elements of the Software 
The following are some of the basic elements in your software: 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
Setup Pane     - Each output device is represented by an icon in the setup pane 
Job Preview Pane   - Double-clicking the job preview pane generates a preview of the 

selected   
job. 

Queues 
In PhotoPRINT Server, files progress through three queues during the course of processing. 

Hold Queue      - This queue lists all jobs that have been sent to the server but have  
not yet been moved to other queues. It is a holding place for jobs 
before they are processed. 

RIP Queue        - This queue lists the jobs that are being RIPed, or have finished RIPing. 
Send Queue      - This topmost queue holds jobs that are in the process of being output. 

Output jobs are automatically deleted from the queue. 
Resizing Queues  - To resize the queues, drag their borders with the mouse. 
Resizing Columns - To resize the columns in a queue, drag the edges of the headers left or  

right. 
 Queue Column Headings 

Setup - The name of the device to which the file will be output. 
Job Name - The name of the file, followed by its internal PostScript name in parentheses. 
Status  - The current status of the job. 
Sender - The name of the computer that sent the job. 
Dimensions - The physical dimensions of the job. 
Copies - The number of copies to be printed. 

 
Information Pane (displays information about the selected job) 

Job Name - The name of the file, followed by its internal PostScript name in parentheses. 
Status  - The current status of the job. 
Sender - The name of the computer that sent the job. 
Dimensions - The physical dimensions of the job. 
Copies - The number of copies to be printed. 
File type - The format of the file. 
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File Size   - The size of the file. 
ICC   - The ICC output profile selected to be used when outputting the job, if any. 
Linearization Table  - The linearization file to use when outputting this job. 
Color    - The color mode of the job. 
After Output   - What to do with the job after output. 
Dither Type   - The dither type selected to be used when outputting the job. 
Type    - The type of job: print or contour. 
Date    - The date and time the job was added. 
# of pages   - The number of pages in the job. 
Resolution   - The resolution at which the job will be output. 
Path    - The path to the folder the file is stored in. 
Toolbar 

A toolbar is located at the top of the main window. It contains tools for the most commonly 
used functions. To show or hide a toolbar, select Toolbar from the View menu.  

 
The toolbar functions are: 

  Add Job  Adds a job to the selected output device. 

  Save As  Saves the selected job to a file. 

  RIP Job  RIPs the selected job, and leaves it in the RIP queue. 

  Print Job  Prints the selected job to the specified output device, RIPing it if necessary. 

   Nest   Nests the selected print jobs together so as to use the minimum amount of  
the output media. 

  Unnest  Unnests the selected set of nested jobs. 

  Abort   Stops selected file from RIPing or printing. 

  Delete   Deletes the selected job or jobs. 
 

Program Menu 
 

File Menu 
 

Add  Adds a job to the selected output device. 
 

Move Job    Moving jobs to a different output device 
 

Job Properties  Window dialog which allows you to edit a large number of settings that  
   

control how a job will be output. 
 

Nest Jobs The ability to combine multiple jobs together in order to minimize the 
amount of material needed to output the jobs. 

 
Unnest Jobs    To separate a set of nested jobs into its component jobs: 
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Export Preset    To export the current settings to a preset file: 
 

Import Preset To import settings that were previously saved to a preset file: 
 

Save As… Saves the selected job to a file. 
 

RIP  RIPs the selected job, and leaves it in the RIP queue. 
 

Send Sends the selected job for RIPing and printing 
 

Abort Stops selected file from RIPing or printing 
 

Exit To exit from the software 
 

Edit Menu 
Select All To select multiple jobs 

 
Delete  To delete selected jobs 

 

Preferences   To set-up archive and file paths, RIP set-up, units, appearance etc. 
 

 
 
Setup Menu 

 
Add Setup Adds a setup to  provide the link between the software and your output 

device. 
Setup Properties  Configuration of Job Workflow, Communication and Automatic Nesting 

 
Default Job  To make the current job properties the default settings for all new jobs 
Properties  that are added to this setup 
Make Active To make an active setup  ready to output jobs. 
Color Profiler An optional provision use for ICC profiling 
Custom Color Allows you to map spot colors to exact output values for your specific 
Mapping output device. 
Global Color Allows you to map the colors in your job using LAB color space, a  
Mapping device-independent color space. 
Output Size Allows you to measure slight variations in output size and  

Compensate for them. 
Test Print  The software allows you to output print and/or contour cut test jobs to 

appropriate output devices. 
 

View Menu 
Tool Bar Contains tools for the most commonly used functions. 

 
Vertical/Horizontal View  Allows you to set the queues and panes in the main window to 

either horizontal or vertical orientation.  
Hide/Show Info Window  To show or hide the information on the Information Pane 
View RIP Log  To view the RIP log 
Clear RIP Log  To clear out the RIP log 
Refresh  To refresh the view of the main window 
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Using Built-In Mathematical Operations 

The software is able to perform a number of calculations whenever a numerical value is 
being entered. 

 
Automatic Unit Conversion 

If you enter a value using a different unit of measurement 
 than the default unit, the software will automatically convert 
 the value to the default unit. 

 
For instance, if your default unit is inches, you can enter a  

value of 1 ft, and the software will convert the measurement  
to 12 in. 

 
Supported Units are; 

 
Calculation of Ratios 

If you enter a ratio in the format A:B, the software will scale the previous value in the field by 
the ratio entered. For instance, if a value is set to 12, and you enter 2:3, the new value will be 8. 

 
Calculation of Percentages 

If you enter a percentage in the format X%, the software will scale the previous value in the 
field by the percentage entered. For instance, if a value is set to 10, and you enter 90%, the new 
value will be 9. 

 
Simple Arithmetic Operators 

If you enter a simple arithmetic expression, the  
software will calculate the result of the expression  
and enter that value in the field. The available  
arithmetic operators, in order of precedence, are: 

  
For example, if you enter 1/8, the value 0.125 will be calculated. Operator precedence 

determines the order in which the arithmetic operations will be calculated when more than one 
operation is specified. In the previous list, operators are listed from top to bottom in order of operator 
precedence. For instance, if you enter 6/2*3, the software will calculate 6/2 first then multiply the 
result by 3, yielding a result of 9. 

 
Automatic Application of Entered Values and Arithmetic 

Once you enter a numerical value, ratio, or arithmetic expression in a numerical field, the 
software will automatically apply that value after a brief delay. There is no need to select another field 
or click an “Apply” button in order to force a calculation or apply a new value to a job preview. 

 
Setting Application Preferences 

To set application preferences, from the Edit menu select Preferences. 
 

The following settings are available: 
Units  -  The units of measurement displayed. 
Precision  -  The degree of precision to use with  
    measurements. 
RIP Band Height  -  Sets the band size that is processed     
    during RIPing. Smaller values allow  
    large files to RIP but will take longer to  
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    process. 
Max number of RIP threads  - Sets the number of jobs that can be  
    RIPed at one time. One RIP thread is  

   required for each file being RIPed, and    
   one RIP thread is required to generate  
   a preview for each file. 

Print while RIPing -  If this option is selected, the software  
   will RIP and print the job    

simultaneously.  RIPing and printing  
simultaneously may affect overall  
performance. 

Allow remote Send Now/  -  If this option is selected, the  
Interactive     software will allow Send Now and   
  Interactive operation from a remote  
  design station. 

 
Exiting the Software 

By default, the software loads automatically each time the OS is restarted (using a shortcut 
in the Startup folder). The software is minimized after starting, and its icon appears in the System 
Tray area of the Windows Taskbar. Clicking the Close button in the top right corner of the title bar ( ) 
minimizes the software instead of closing it. 

 
To exit the software, from the File menu select Exit, or right-click on the software icon in the 

system tray and select Exit from the context menu. 
 

Working on Setup 
 

Changing/Adding New Setups 
To change the setup in use or add new setups: 

1. From the Setup menu, select Change Setup or Add Setup. 
2. Click the Manufacturer and Model of your setup 
3. Provide for the Setup Name 
4. Click Finish after specifying the Flora Port.. 

  
Selecting a Setup 

To select a setup, highlight its icon in the Setup Pane. Only one device can be 
selected at any time. 

 
Activating Setups 

An active setup is a setup that is ready to output jobs. To make a setup active, do 
one of the following: 

• Check the box next to its icon in the Setup Pane. 
• Select the setup icon, then from the Setup menu, select the Make Active. 
• Right-click on the setup icon and select Make Active from the context menu. 

 
Deleting Setups 

To delete a setup, do one of the following: 
• Select the setup icon in the Setup Pane and click on the Delete button in 
the toolbar. 
• Select the setup icon in the Setup Pane, then from the Edit menu, select 
Delete. 
• Select the setup icon in the Setup Pane and press the Delete key on your 
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keyboard. 
• Right-click on the setup icon in the Setup Pane and select Delete from the 
context menu. Deleting a setup will also delete all jobs associated with the 
setup. 

 
Editing Setup Properties 

To edit the setup properties associated with a particular output device, do one of the 
following: 

• Right-click the setup icon in the Setup Pane and select Properties. 
• Select the setup icon in the Setup Pane, then from the Setup menu, select Setup  

Properties. 
• Double-click the setup icon in the Setup Pane. 

 
Setting Default Job Properties 

The Job Defaults button allows you to set the default job properties for this setup. 
All jobs that are manually added to this setup will inherit the default job properties. Jobs sent 
from a client application will use the job properties set in the client application. This is useful 
because it allows you to create multiple specialized setups for each output device. One 
setup might have the default settings for a proof copy, for instance, while another might be 
preset for final output.  

 
Using multiple setups this way prevents you from having to change the job properties 

for each stage of each job. You can also set the default job properties by clicking the Save 
as Default button in the Job Properties dialog. 

 
Using Output Size Compensation 

Output Size Compensation allows you to measure slight variations in output   
and compensate for them. To use Output Size Compensation with a given setup: 

1. Select the output device setup. 
2. From the Setup menu, select Output Size Compensation. 

 
 
 
 
 
 
 
 
 
 
 
 

3. If you are using a hybrid device, and you want to apply output size compensation 
to the device’s cut output as well as its printed output, check Compensate also 
cut size. 

4. Enter the Width and Length of the test print you want to output under Test size. 
For best results, the print should be as large as possible while still fitting onto the 
output media. 

5. Click Test Print. 
6. Measure the actual size of the test print and enter the Width and Length of the 

test print under Measured size. 
7. The software automatically calculates the compensation factors that will scale the 

output size to compensate for the difference between the test size and the 
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measured size. 
7. Check Enable output size compensation to automatically scale all future output 

from this setup using the compensation factors derived from your measurements. 
8. Click OK.   

 
Note:   You must set up Output Size Compensation separately for each output device setup. Output 

size compensation does not affect the size of the job as it appears in the Job Properties 
dialog. 

 

 
 

Working With Print Jobs 
 

Adding New Jobs - Jobs can be sent to the software in a number of different ways. 
 

Adding Jobs from a File 
To add a file as a new job: 

1.  From the File menu, select Add Job. 
2.  Select the file to be added. 
3.  If you want to copy the file to the local job folder, check Copy to job 

folder. 
4.  If the job is on removable media or a network drive, copying it to a local 

folder will allow you to process the job after removing the media or 
disconnecting from the network. 

5.  Select the Setup you want to use to print the file. 
6.  Select the Preset whose settings you want to apply to the job. 
7. Click Add. 

 
Copying the File to the Hot Folder 

Each output device that has a setup in the software has a hot folder. The hot folder is 
used to store all the files that are queued up for that output device. By default, hot folders are 
installed in the C:\Program Files\[Software]\Jobs folder. 

   
The software continuously monitors each hot folder. Whenever a job is copied or 

moved into a hot folder, it will automatically be added to the Hold Queue. 
 

Dragging a File into the Software 
Dragging a file into the software will automatically add it to the list of jobs in the Job 

Area. The job will be assigned a status of Holding. The file must be of a supported file type.  
 
  

Selecting Jobs 
Multiple jobs can be selected using the standard Windows CTRL and SHIFT methods: 

• Hold the CTRL key to select multiple individual jobs. 
• Hold the SHIFT key to select a range of jobs by clicking on the first and last jobs in 

the range. 
• To select all the jobs, from the Edit menu select Select All. 

 
 

Setting Job Properties 
The Job Properties dialog allows you to edit a large number of settings that control 

how a job will be output. 
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Processing Jobs 

Once the server receives a job, it can be RIPed and printed. 
 

Moving jobs to a Different Output Device 
To move a job to a different output device setup, do one of the following: 

• Select the job and select Move from the File menu, then select the new setup and 
click OK. 

• Click and drag the job onto the icon for the new output device’s setup in the Setup 
Pane. 

 

RIPing Jobs 
To RIP a job, do one of the following: 

• Select the job and from the File menu, select RIP. 
• Drag the job into the RIP Queue with the mouse. Once a job is moved into the RIP 

Queue, it will automatically be RIPed if it has not been RIPed previously. 
• Right-click the job and select RIP from the context menu. Jobs in the RIP Queue 

will process in the order of the Job Priority setting in their Job Properties. When 
multiple jobs with the same priority are waiting in the queue, the job that was 
received first will process first. 

 
Printing Jobs 

To print a job, do one of the following: 
• Select the job and from the File menu, select Print. 
• Right-click the job and select Print from the context menu. 
• Drag the job into the Send queue with the mouse. Once a job is moved into the 

Send queue it will be automatically be RIPed if it has not been RIPed already. It 
will then automatically be printed on the appropriate device. Jobs in the Send 
queue will process in the order of the Job Priority setting in their Job Properties. 
When multiple jobs with the same priority are waiting in the queue, the job that 
was received first will process first. 

 
Aborting the Processing of a Job 

To abort the processing of a job while it is being RIPed or printed, do one of the following: 
• Select the job and from the File menu, select Abort. 
• Select the job, then click on the Abort button in the toolbar. 
• Right-click the job, then select Abort from the context menu. 
• Drag the job back into the Hold Queue with the mouse. If a job is aborted while 

being RIPed, its status is set to Aborted. It will need to be RIPed again before it 
can be printed. If a job is aborted while being printed, its print status freezes at 0%. 

 
Deleting Jobs 

To delete a job, do one of the following: 
• Press the Delete or Backspace key on your keyboard. 
• Select the job and from the Edit menu, select Delete. 
• Select the job, then click on the Delete button in the toolbar. 
• Right-click the job, then select Delete from the context menu. 

 
Outputting Test Jobs 

The software allows you to output print and/or contour cut test jobs to appropriate output 
devices. 
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Outputting a Test Print Job 

To print a test job: 
1. Select the setup you want to send the test job to. 
2. From the Setup menu, select Test Print. 

 
Using the RIP Log 

Each time a job is RIPed, an entry for that job is added to the RIP Log. The RIP Log entry 
lists the relevant details about the job: where it came from, its basic characteristics, job property 
settings, and the RIP time. 

 
Viewing the RIP Log 

To view the rip log: 
1. From the View menu, select View RIP Log. The RIP Log is formatted as an HTML 

file, and displays in the default browser for the operating system. 
 
Clearing the RIP Log 
To clear out the rip log: 

1. From the View menu, select Clear RIP Log. 
 
  

Setting Job Properties 
The Job Properties dialog allows you to edit a large number of settings that control 

how a job will be output. 
 

Accessing the Job Properties Dialog 
To access the Job Properties dialog, select the job and do one of  
the following: 

• Double-click on the job. 
• From the File menu, select Job Properties. 
• Right-click on the job and select Job Properties from the context  

    menu. 
 

The left side of the dialog contains the tabs on which the job  
properties can be set. The right side contains a preview pane that  
displays the job as it will appear on the output. 

 
Setting the Preview Pane View 

Select one of the three available views from the list at the top of the preview pane: 
  

Page preview 
Displays each page of the job scaled to fill the preview area. If there is more than one page 

in the job, a list of the page numbers will appear above the preview, allowing you to select the page 
to display.  

If you are using PhotoPRINT SE, only the first page will be displayed in Page Preview. 
Selected automatically when the Workflow, Color Management, Printer Options, Cut, or Color 
Adjustment tab is selected. 

 
Layout preview 

Displays the job as it will appear on the output media. The preview is scaled so that the 
output media fills the preview area. Selected automatically when the Layout, Labels, or 
Separations tab is selected. 
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Tiling Preview 

Displays the job with the outlines of the tiles that it will be broken up into superimposed over 
the image. Selected automatically when the Tiling tab is selected. 

 
 
 
 

              
 

 
 
 
 
 
 
              
 

Setting Default Job Properties 
To make the current job properties the default settings for all new jobs that are added to this 

setup, click Set Default. You will be asked to confirm the change in the default settings. 
 

Setting Job Properties 
Different tabs within the Job Properties dialog let you set layout options, tiling/paneling 

options, color calibration options, color adjustment options and labels. The exact number of tabs and 
the settings on those tabs will vary depending on the type of job and output device selected, as well 
as the version of the software in use. 

 
Layout Tab 

The Layout tab controls how the job will be positioned on the output media, what size it will 
be, and the layout of the output. 

 
Media Size 
The size of the media loaded into your output device. Select  
from one of the preset sizes, or specify unique dimensions  
below. 

  The width and height of the media 

  The margins of the printable area  
 
When a set of unique dimensions is specified, it is automatically 
added to the list of preset sizes. 
 
Borderless  If checked, the job dimensions will  
printing  automatically be set for borderless (full bleed)  
 printing. Only media sizes that support  
 borderless printing will be listed. If a different  
 media size is selected, the job dimensions  
 will automatically be adjusted to match the  

new size. 
 
Job Size  Choosing one of these options allows you change the 

output size and orientation of the page. 

 
Page Preview 

 
Lay-out Preview 

 
Tiling Preview 
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  The job's width and height. 

  The job's width and height as a percentage of the 
original. 

Fit to Media  Scales the job proportionally so that it is as large as 
possible while still fitting within the printable area of 
the output media. 

Proportional  When this option is selected, the height and width of 
the job are increased or decreased together to keep 
the original proportions intact. 

 
 

Position These settings change the position of the job on the media.  

 The distance between the job and the right and bottom margins of the printable area. 

  Places the job at the specified distances from the lower and right edges of the 
printable area of the output media. 

  Centers the job along the width of the printable area. 

  Centers the job in the middle of the printable area. Only available for sheet material. 

  The number of copies to be output. 

  The amount of space that will exist between the various tiles, copies, and/or nested 
jobs that will be output as part of the job. 

 
 

Page Range  If checked, you can specify the range of pages that will be output for a multi-page 
job. Format is x-y. Also accepts “,” to put in multiple ranges. 
Ex: 5 Prints page 5. 
2-5 Prints pages 2, 3, 4 and 5. 
3, 5-10 Prints pages 3, 5, 6, 7, 8, 9 and 10. 

 
Page Nesting If checked, the pages, tiles and color separations of the job will automatically be  

nested. 
  Flips the selected image on the vertical axis, so that your image will 

be mirrored when printed. 
 
Rotates image on the media in 90-degree increments. Click the 
button until you achieve the desired orientation. 

 
 

Workflow Tab   
The Workflow tab displays settings related to the time and order that the job will be 

processed in. 
 

Setup name  - Name of the setup. 
Hot folder  - The folder that the software will use to  
  store job files for this output device. 
Share Name  - The share name assigned to the setup. 
After Receive  - Sets what to do with jobs after they are  
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    received: 
Hold       -  Places jobs in the Hold Queue. 
Auto Start  -  Begins processing jobs immediately. 
Schedule  -   Outputs jobs at the time specified in the Output Time field. 

Output Time- If Schedule is selected, this field allows you to enter the time 
at which the queued jobs will begin to be processed. 

Rotate image to fit media - If checked, the image will automatically  
be rotated to better fit the dimensions of the output media if 
needed. 

 
 
 

Communication Tab  
The Settings section of this tab changes depending on the port used to connect to the 

output device. Ports are listed in order of popularity for each device. Only the ports that are 
usable by the output device are listed. The standard port for the device is selected by default. 
Some of the port settings may still need to be entered or edited, however. 

Port  - Select the port to which the output device is connected. The port list 
is limited to the ports that are actually present on your computer and 
usable with your  output device. 

FILE  - The File port allows you to save the output data as a file. The 
following settings are available:  

 Prompt for file - If checked, you will be prompted to path for each file    
provide a filename for the output file when each job is saved to a file. 

TCP/IP - Use this port if your output device supports network connection. 
TCP/IP address - The TCP/IP address of the output device (required). 
Port Number  - The port number used for printing to the output device. 

Select from the list or enter a custom number. 
 
 

Color Management Tab  
The Color Management tab displays the settings related to the printing device. The layout 

of this tab may differ depending on the output device. 
 

Preset  Select a job properties preset to apply to the job. 
Media  Select the media type the output will be printed on. 
Print mode Select the print quality for the output. This setting will vary 

for each type of printer. 
Gradient Smoothness Select Normal, Enhanced or Super. The 

higher settings cause the software to render gradients using 
more elaborate algorithms that produce smoother  
dithering. 

Color Mode  Select the color mode that matches the inks set in the 
printer. 

CMYK The image will be printed using a combination of cyan,  
magenta, yellow and black inks. 

CMY   The image will be printed using cyan, magenta and yellow  
inks. All black will be CMY process black. 

Grayscale The image will be printed using black ink only, producing a 
black and white image with shades of gray. 

CMYKLcLm CMYK plus Light Cyan and Light Magenta inks. This color 
mode provides smoother Gradations between lighter shades 
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of colors. 
Dither type  Select the dithering for the output. It is the pattern in which the individual dots that 

make an image are applied to the media. Each dither type has advantages in terms of 
quality and RIP 

 speed. The default dither type is usually the best setting for your machine.  
 
 The software offers several dithering options to optimize your output. Usually,  
 quality and speed are in tradeoff, with KF Diffusion offering the highest quality 
 and the LX Diffusion or FMXPress offering the fastest processing times. 
 The available patterns (in descending order of quality) are: 
 
 KF Diffusion This is an enhanced version of the error diffusion method. While it takes longer to  
   RIP (5-6 times more than FMXPress), it provides the highest detail and contrast for  
   most inkjet printers. 
 
 Error Diffusion This method produces high-quality images. The enhanced image quality requires 

intensive processing (3-4 times more than FMXPress), and the time it takes to RIP a 
file using this method is the second longest of the available options. 

 
 Random Diffusion A balance between image quality and RIP time. It takes 2-3 times longer than 

FMXPress. 
 
 FMXPress  The default diffusion method. It’s the fastest in terms of RIP time and is suitable for  
   most prints. 
 
 LX Diffusion A faster option as far as RIP times are concerned. It’s a good choice for large  
   prints that will be viewed from a considerable distance. 
 
 Angled Screen Designed for use with thermal printers to produce vibrant, saturated colors. This is  
   also used to produce screen print positives. Click Screen to set advanced options.  
 

Smooth blends Select Normal, Enhanced or Super. The higher settings cause the software to  
 render gradients using more elaborate algorithms that produce smoother dithering. 
 

Perform color correction   Checking this option activates the color correction settings. If this setting 
is not checked, incoming jobs are assumed to have already color corrected in the 
design application. If color correction is off, the software will use a generic CMYK 
profile, instead of a profile generated from actual color measurements of output from 
the device. 

 
Output profile Once the image is in a neutral color space, the output profile is used to convert the  

 image into the color space of the output device. 
 
 Select the ICC profile that matches the combination of ink, media, resolution, and  
 dither type of your output device. To add an ICC output profile from another source, 
 select Add from the list of available profiles. 
 

Properties  Clicking the Properties button will launch the Profile Properties dialog, which  
 contains information pertaining to the ICC output profile that has been selected. 
 

Advanced  Click to set advanced color correction properties.  
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Linearization Table Simulation  Select the linearization table to use. 
 Printer simulation allows you to simulate the output of one printer on another. You 

 can simulate a large format job on a small format printer. To simulate the output of  
 another printer, select Add from the Simulation list. 
 

Select an ICC profile from the device that you want to simulate and click Open. Printer 
simulation does not support the spot color rendering intent. If you try and output an 
object that has been assigned the spot color rendering intent while using printer 
simulation, an error message will be displayed. 
 

Ink Limits  Click to set the ink limits for the output device. 
Set the ink limit for each color of ink to the maximum percent coverage that the 

device can output without causing bleeding or drying issues, then click OK. Click Ink 
Split to determine when a light or medium colored ink will be used instead of the 
normal ink. This feature is only present for output devices that use light or medium 
colored inks. 
 
 
 
 
 

 
 
 
 
 
 
Use Color Mapping Check to print spot colors based on settings in global and custom color 

mapping. Click Color Mapping to set custom color mapping options.  
 

Ignore overprint If this option is selected, the software will ignore any overprint settings that may exist 
in jobs it outputs. 

 

Tile Tab  
The tiling feature of the software allows you to split a print job up into a number of smaller 

tiles that are then output separately. This can be used to produce a larger job than a device is 
capable of outputting in one piece. 

 
Tiling and Cropping Jobs 

The tiling feature of the software allows you to split a print 
job up into a number of smaller tiles that are then output 
separately. If a job is larger than the output media, it is 
automatically tiled into pieces small enough to output. When a 
job is rotated or resized, all tiling is removed. If the job is larger 
than the output media after it is rotated, it will automatically be 
retiled. All tiling is done from the Tile tab of the Job Properties 
dialog. To access the tiling features: 
1. Select the job. 
2. From the File menu, select Job Properties. 
3. Select the Tile tab. 
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The following settings are available: 
Panel Size  The panel is the part of the job that will be split up into tiles and output by the 

software. If the panel is reduced in size so that it does not cover the entire job, only the parts 
covered by the panel will be output. 

  Shows the width and height of the panel. To adjust, enter a number or use the 
arrows. 

  The size of the margin. The margin is the part of the panel that extends outside 
of the boundaries of the job. 

 
Selected Tile 
        Selects which tile’s width and height are displayed in the fields below. 

  Selects a tile to be edited. The selected tile is highlighted in the preview pane. 
  Shows the width and height of the selected tile. To adjust, enter a number or use 

the arrows. 
Print  If checked, the selected tile will be output with the rest of the job. If cleared, the tile is 

marked with a mesh overlay in the preview pane, and will not be 
output. 
 

All Tiles  These settings apply to all tiles and help you quickly set up automatic tiles, of equal 
size. 

    Selecting this option divides the job vertically into the number of columns specified.  
Each column will be of equal width. 

     Selecting this option divides the job into the number of rows specified. All rows will  
be of equal height. 

   If you know that you want tiles of a certain size, enter the values for the width and  
height of the tiles here. All tiles will be changed to the specified size. 

     Sets the amount of overlap between tiles. Enter a negative number to create an 
offset between tiles. 
 
 

Automatic If Automatic tile flip is checked, every other tile that is printed will be rotated 180° so 
tile flip that adjacent vertical edges are always printed with the same side of the print head. This 

helps them match up cleanly. 
                      
Print Tilemap  Outputs a tile map to aid in assembly of the    

finished job. 
Reset  The reset button will restore the original values and settings. 
 

 
Dividing a Job Into Tiles 

The job starts as a single large tile that covers the entire job. This tile is selected by default. To 
divide the job into multiple tiles, reduce the width and/or height of the first tile using the        and       
fields in the Selected Tile section. New tiles will automatically be created to cover the exposed areas 
of the job. 

   
For instance, to divide a 30x25 job into two vertical tiles, set the field to 15, reducing the size of 

the first tile to 15x25. A second 15x25 tile will automatically be created. 
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Dividing a Job into Uniform Rows and Columns of Tiles 
To divide the job into a specified number of uniform rows and columns of tiles: 

1. Check  or  to tile the job vertically or horizontally. 
2. Enter the number of columns of tiles in the   field. 
3. Enter the number of rows of tiles in the   field. 
4. Set the amount of overlap between the tiles in the   field. 

 
      
 
 
 
 
         
 
 
 
 

Dividing a Job into Uniform Tiles of a Specified Size 
To divide the job into uniform tiles of a specified size: 

1. Check   and  to set all tiles in the job to be of the specified size. 
2. Set the   and   fields to the width and height desired for the tiles. 
3. Set the amount of overlap between the tiles in the   field. 
4. If the specified tiles do not cover the job evenly, the tiles at the top and right edges 

will be made small enough to fit in the gap. 
 
 
 
 
 
 
 
 
 
 
 

Selecting a Tile 
To select a tile, either click on the tile in the preview pane, or select the tile using the  field 

in the Selected Tile section of the Tile tab. 
 

Editing Tiles 
To edit the size of the selected tile, change the values in the  and   fields. 

You can also resize tiles by dragging their edges in the Preview Pane. 
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Click and drag to resize 
-  If any of the Tiles checkboxes are checked, the  and  fields may be disabled. In this 

case, the fields have been overridden in order to keep all tiles uniform. The tiles will not be editable 
using the Preview Pane either. If you drag the edges of the panel over so that part of the job is 
exposed, a new tile will be created to cover the exposed area of the job. The exception to this is if 
you resize the panel using the cropping handles. Click and drag the edge of the panel to add another 
tile. 

 
 
 
 
 
 
 
 
 
 

Preventing a Tile From Being Output 
To prevent a tile from being output with the rest of the job: 

• Double-click on the tile in the preview pane. 
• Right-click on the tile in the preview pane. 
• Select the tile in the Selected Tile section of the Tile tab and clear the Print 

checkbox. 
• Non-printing tiles are marked with a hash pattern. 
• Double-click or right-click the tile again to toggle it back on. 
• Select the tile in the Selected Tile section of the Tile tab and check the Print 
checkbox. 

 
Note:  One tile in each job must always remain printable. If you try to set all tiles to non-

printing, one of the tiles will become printable again. 
 
 
 
 
 
 
 
 
 
 

Printing a Tile Map 
The software can print out a map showing how the job will be broken up into tiles. Each tile 

has the tile number printed within its outline. 
 

To print a tile map: 
1. Click the Print Tile Map button on the Tile tab. 
2.  Select the printer you want to use to print the tile map. 
3.  If you would like to send the tile map to a desktop or network printer,  

                first create a setup for that printer, then select that setup here. 
4.  Click OK. 
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Cropping a Job 
To crop out part of a job so that it will not be output: 

1. Open the Job Properties dialog for the job. 
2. Select the Tiling Preview view of the job. 
3. Drag the red cropping handles so that the unwanted parts of the job are cropped 

out. Cropped-out areas of the job will not be output. 
 

You can also crop a job by reducing the panel size using the   ,  and  fields in the 
Panel Size section of the Tile tab. 

 

         
 
 
Removing All Tiling and Cropping 
To remove all tiling and cropping and make the job one piece again, click on the Reset button. 
  If the job is bigger than the media, it will still be tiled to fit the media. 

Labels and Marks Tab   
You may choose to print crop marks, and information about the job along with any notes that you enter. 
 

Color  Select the ink that will be used to print labels and marks. 
Width  Sets the width of the labels. 
Print Labels  This option must be checked to have access to label 

printing options. 
Position  Select where to print labels relative to the job. 
Font and Size Allows you to select a font and font size. 
Printer Name  Prints your printer name on printout. 
Resolution Prints the resolutions settings on printout. 
ICC output Prints the ICC output profile used on the printout. 
Profile 
Tile Number Prints the tile row and column number. 
Overlap  Prints the overlap distance between tiles. 
Job name, size and type  Prints the job name size and type on the 

printout. 
Dither type  Print the selected dither type on the printout. 
Starting time of RIP Prints the time that the RIP process started on 

printout. 
Page number  Prints the page number for a multiple page file. 
Number of Copies  Prints the number of copies made on printout. 
Notes  Allows you to print a text note on printout. 
Print Marks Allows you to select type of crop marks to be used on 

printout. 
   Only the crop mark supported by the output device will 

appear in the list. 
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None  No print marks. 

 
 

Crop Marks  
Crop marks will be printed at the corners of the job to allow the job. 

 
 
Standard Marks    
Standard marks intended for aligning color separations. Automatically turned on  
whenever color separations are output. 
 
Swatch     
Color swatches for each color of ink will be printed around the job. 
 
 
Overlap Marks   
Overlap marks will be printed, indicating how the tiles of a tiled job should overlap. 
 
  
Tonal Scale   
Color swatches containing blended CMY colors and a gray scale will be printed  
around the job. 
 
Margin     
Marks will be printed at the corners of the job indicating its outside margins.  

 
 
Border     
A border will be printed around the outside edge of the job. 
 
Tile overlap lines 
Check to print lines on tiles indicating where the edge of the overlap is. These  
can then be used to align the tiles. If On both tiles is checked, the overlap lines  
will appear on both tiles. If not, the overlap line will only appear on the second tile. 
 
Print color bands 
Check to print color bands at the positions selected. Color 

 
 
 
 

Color Adjustment Tab   
The Color Adjustment tab provides some basic tools to manually adjust the  

output color. Each color channel is listed separately as a linearization curve that determines what 
percentage of coverage will be used (output) for a specified percentage in the original image (input). 

 
Preview  Check to see the changes in your color settings reflected in the 

preview pane. 
Channel  Select the color channel that you want to edit. 
Output  The value for the point that is currently selected on the 

linearization curve. 
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  •  Click on the curve to select a different point to edit. You can also  
        select a point by clicking on the input axis label. 
  • To change the value at given point on the curve, edit the value in the  
       Output field, or click and drag the point up or down. 
 

Contrast  Adjusts the amount of contrast in the image.This setting is only 
available when All color channels are selected. 

 
Vividness   Adjusts the vividness of the image. Higher settings boost color 

saturation and brightness at the expense of color fidelity and detail. 
Lower settings decrease color saturation and brightness, but increase 
contrast. 
- This setting is only available when All color channels are selected.  
Also, you must have an ICC profile selected in the Color Management 
tab. 

 
 

Advanced Click to edit the color settings in the image using a more advanced model. 
 

 
 

- This setting is only available when All color   
channels are selected. Also, you must have an 
ICC profile selected in the 
Color Management tab. 
 
Brightness  Higher values make all colors in 
the image lighter in shade. Lower values darken 
the colors in the image. 

 
Global Hue  This setting adjusts the overall hue of the picture. It can make the image bluish, or 

sepia-toned. For this setting, the range of values from -100% to +100% represents the 
spectrum of colors that can be applied to the image. 

Saturation  Higher values increase the amount of color in the image, but can reduce the contrast 
and detail. Lower values reduce the amount of color. 

Reset       Click to reset all sliders to their defaults. 
OK      Click OK to accept changes and return to the Color Adjustment tab. 
Delete       Click to delete the selected point from the linearization curve. 
Reset       Click to restore the values and settings for the current channel to its original states. 
Reset All    Click to restore the values and settings for all channel to their original states. 

 
Separations Tab   

The Separations tab contains a number of options related to printing color separations. 
Print as separations 

Check to print each color plane separately. To print separations for certain 
colors only, clear the checkboxes for the colors you do not want to print. 
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Print separations in color 
Check to make each process color separation print in the 

appropriate color of ink. If this option is not  selected, all process color 
separations will print in black. 

Separations for spot colors will always print in black. 
 

Edit   Click to edit the way that color channels will be output. 
 
 
 
 
 

 
Setting Angled Screen Dithering Options 

If you have selected the Angled Screen dither type, you can edit the dithering options 
for each color from the Separations tab.  

 
Editing Color Channel Details 

If the Print as Separations box is checked, but Print separations in color is not 
checked, you can select how the separations for each color channel will be output by 
selecting the desired color channel and clicking Edit. 

The Channel Details dialog will open. It will look different depending on whether the 
color channel is for a process color or a spot color. 

For process colors, set Print as to the color of ink you want to use to output the color 
channel, and click OK. 

For Spot colors: 
1. Set Print as to one of the following: 

Process Spot colors will be converted to their best process color 
approximations and included in the process color separations.  

Spot    Each spot color will be printed as an individual separation using  
black ink. 

2. Check Apply to all spot colors to apply the settings for the current color to all 
spot colors. 

3.  Click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Object Color Control Tab    
The Object Color Control tab in the Job Properties dialog allows you to 

map the colors in a job to the device-specific process color values that will be used to output the     
colors. 

 

 

 Process Color 
 Spot Color 
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If the Preview box is checked, the preview pane will update to reflect 
any color mapping and editing that you do. 
 
Inspecting Colors 
To view the output color values currently assigned to objects or areas in 
your job, simply move the mouse over that object or area. The output 
color values will be displayed in the Object Color Control tab, in the area 
above the list. 
  Object Color Control does not support spot colors. Spot colors are 
automatically replaced by the process color used to display them. 
 
Selecting Colors 
To select a colored object or area, click on it in the preview pane. The 
color will appear in the list. If you click on the same color again, the 
color will be highlighted in the list. 

 
Setting Color Mappings to be Enabled or Disabled 

To enable a color mapping, check the box next to it. Clearing the box disables the mapping. 
Editing Colors 
To edit the output color values for a given color in your job: 
1. If you have not already selected it in the design, do so (see above). 
2. Select the color in the color list. 
3. Click Edit. 
4. Set Color Space to the color space you want to work in: 
5. Edit the color values for the color. 
- Color values are always specified for the color at 100% coverage. If a tint 
was specified, the software will assume that the specified color values are 
for 100% coverage, and will compute the actual output values based on 
the percentage of coverage specified for the tint. 

6. Check whether you want the color mapping to apply to Bitmap objects, 
Vector objects, or All objects. 

7. Click OK.  
 

Adding New Colors 
It is possible to add new color mappings to the list, even if the original colors are not 

contained in the job. This may be useful if you want to save the color mappings to a preset file for 
use with other print jobs, 

For example: if you know that most of your jobs will contain the spot color 
Company_Logo_Purple, you can add a color mapping for that color even if it doesn’t appear in the 
current job. You can then save all the color mappings to a preset file, and reapply them to future jobs 
in one step. 

To add a new color mapping to the list: 
1. Click New. 
2. Select Input Color. 

a. Set Color Space to the color space of the new color. 
b. Enter the color values for the new color as they would appear in a job. 

3. Select Output Color. 
a. Set Color Space to the color space you want to use to specify the output color. 
b. Enter the color values for the output color. 

4. Check whether you want the color mapping to apply to Bitmap objects, Vector objects, or 
All objects. 

5. Click OK. 
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Resetting Color Values 
To clear the color list and reset the color mappings to their original state, click Reset. 
 

Saving Object Color Control Settings to a Preset 
You can save color mappings to a preset the same way you save any other Job Property 

settings. It is possible to make a preset that contains ONLY color mappings. Simply uncheck all other 
settings apart from Color Mapping. Selecting a preset saved in this manner will load the color 
mappings from the preset while leaving all other settings untouched. 

 
Adding New Media Types to a Device 

The software allows you to add new media types to the list of media types for a given make 
and model of output device. The new media type will only appear for that make and model of device, 
not for all devices. 

To add a new media type: 
1. Select a setup for the device you want to create a new media type for. 
2. From the Setup menu, select Default Job Properties. 
3. Select the Color Management tab. 
4. From the Media Type list, select Add Media. 
5. Enter a Name for the new media type. The name can be up to 32 characters long, 

and may not contain any wild card characters (#, *or ?). 
6. Click OK. 

 
 
 
 
 
 
 
 
 
 
 
 

Removing Media Types 
To remove a media type that has been added for a certain output device, select it in the 

Default Job  Properties dialog and click Remove. The default media types defined by the software 
cannot be removed.  
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Setting Ink Split Options 
The Ink Split Curve dialog allows you to set the points at which light or medium colored inks 

will be used instead of normal “dark” inks. This provides a greater number of light-colored shades, 
and reduces banding in light-colored areas. Ink split is only used when a color mode that includes 
light such as CMYKLcLm is selected. 

To access the Ink Split Curve dialog: 
1. Open either the job properties or default job properties dialogs: 

• From the File menu, select Job Properties. 
• From the Setup menu, select Default Job Properties. 

2. Select the Color Management tab. 
3. Click on the Ink Limits button. 
4. Click on the Ink Split button. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Each shade of ink is represented by a curve plotted on the chart. The chart illustrates the 
amount of each shade of ink that will be output in order to provide a certain amount of coverage. The 
range of coverage that can be specified in the image (0% to 100%) is plotted on the X-axis, and the 
corresponding coverage of each shade of ink is plotted on the Y-axis. 

 
The available settings are: 

Channel   Select the color channel you want to edit ink split settings for. Only the color 
channels that have multiple shades of ink on the current printer are listed. 

Light Ink Peaks At  The point on the X-axis at which the light ink curve peaks. 
Maximum Level of Light Ink The amount of light ink coverage at the peak of the light ink 

curve. 
Light Ink Ends At  The point on the X-axis where the right side of the light ink curve hits its 

minimum value. 
Minimum Level of Light Ink  The minimum amount of light ink coverage for the right end 

of the light ink curve. The light ink curve always starts at the origin. 
Middle Level of   The amount of dark ink coverage at the point where the right side of the  

light ink curve Dark Ink hits its minimum value. 
 

Light Peak Smoothness The amount of curve present at the peak of the light ink curve. 
                Select 0 for a sharp peak. 
 

Light End  The amount of curve present at the point where the right side of the light ink 
curve hits Smoothness its minimum value. Select 0 for a straight line. 

 
 Dark Ink Start Smoothness The amount of curve present at the start of the dark ink curve. 
 Select 0 for a straight line. 
  Dark Ink Middle Smoothness  The amount of curve present in the middle of the dark ink  
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curve. Select 0 for a straight line. 
 
 Reset Undo Click to restore the ink split settings for the current channel to the factory  

defaults. Click to undo the last change made to the ink split settings. 
 
 Apply to All  Click to apply the current ink split settings to all color channels. 

 
Setting Advanced Color Correction Properties 
To edit the advanced color correction properties for a job: 

1. Open the job properties for that job. 
2. Select the Color Management tab. 
3. Click on the Advanced button. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Setting ICC Input Profiles 

Select the ICC input profile to use to convert the image into a neutral color space. There are    
          three types of ICC input profiles that can be specified. 
 

CMYK  The CMYK input profile applies to all elements of a job that are in CMYK color mode. 
If your image is in CMYK color mode, then your file was previously separated for 
output to a specific output device. Whenever is possible, use the profile used for 
separation in your design application as the CMYK input profile. Try using similar 
profiles for common ink sets (such as CMYK SWOP or High End SWOP) if you don’t 
have the matching profile. 

 
RGB  The RGB ICC input profile applies to all elements of a job that are in RGB color 

mode. An RGB input profile can be for either a monitor or a scanner. If you scanned 
your image without color correcting it, it is recommended to use the scanner profile 
as a RGB input profile. If you have done any on-screen color correction, you should 
select your monitor profile as a RGB input profile. 

  
    Gray  The Gray ICC input profile applies to all elements of a job that are in grayscale color  

mode. This may refer to either a grayscale scanner or a grayscale monitor. 
 

Check Use embedded ICC profile to force the RIP to use the input ICC profile 
embedded in the file. The name of the embedded profile is listed. If Use CMYK 
Simulation is checked, RGB images will be imported using the RGB input profile, 
then converted to CMYK and reimported using the CMYK input profile. 

Adding ICC Profiles from Other Sources 
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To add an ICC input profile from another source, choose Add from the combo box. 
 

Setting Rendering Intents 
Rendering intent specifies how a color space from the input file gets mapped to the color 

space of the output device. Rendering intents can be specified for four different types of 
objects that make up jobs: 

 
Bitmap   The rendering intent to use with bitmap images (raster images) contained in your job file.    

 
Vector   The rendering intent to use with vector objects such as circles, polygons, lines, arcs and  

Bezier curves contained in vector-based files like PostScript, DXF or Adobe Illustrator. 
Text     The rendering intent to use with text objects contained in PostScript and other vector-

based files. 
Gradient  The rendering intent to use with vector-based gradient objects contained in PostScript and 

other vector-based files. Gradients created in bitmap files will be rendered using the 
Bitmap rendering intent. 

 
If a type of object does not appear in the current job, its rendering intent will be disabled. 

Text objects are only detected in PostScript-based files (PS, EPS, PDF) in which the text has 
been saved as a text object (not saved as paths). 

 
Different rendering intents can be specified for CMYK objects versus all other objects (RGB, 

grayscale, LAB,  etc.). 
 

Choose from one of the following rendering intents: 
Perceptual  This intent is best for photographic images. Colors outside of the output device’s 

gamut are either clipped or compressed to fit the output device’s color space. 
 

Saturation  This intent is best for graphic images, such as vector art, where vivid colors are 
more important than true color matching. Colors outside of the output device’s gamut 
are mapped to colors at the extent of the gamut’s saturation. Colors that fall within the 
gamut of the output device are shifted closer to the gamut’s saturation extent. 

 
Relative This intent is best for images, such as logos, where the output needs to match the 

original 
Colorimetric  image. Colors that fall outside of the output device’s gamut are clipped. This 

method may reduce the total number of colors available. The white point of Relative 
Colorimetric is always zero 

 
Absolute This intent is similar to Relative Colorimetric, but has a different white point value. 
Colorimetric  Absolute Colorimetric represents colors relative to a fixed white point value of     

D50. For example, the white of paper A will be simulated when printing on paper 
B. This intent is best for color proofing. 

 
Spot Color  This intent was created to supplement the Saturation intent. Spot Color maps 

colors similarly to the Saturation rendering intent, but Spot Color rendering intent 
produces the greatest saturation possible, and should not be used with photographic 
images. 

 
No color correction  The object will be printed without any color correction. 

 
Print Transparent as White 
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If this box is checked, transparent areas of the design or areas in which there are no 
objects will be printed in white, instead of being left blank. 

 
Using Pure Hue Settings 

The Pure Hue buttons allow you to specify that certain color channels should not be 
mixed in with other colors when the job is rendered. These settings can be different for each of 
the 4 types of object. For instance, if a job contains yellow text, you could check the Pure Hue 
setting on the yellow color channel for text, so that no other colors appear in the yellow text. 

 
To adjust the Pure Hue settings for a type of object: 

1. Click the Pure Hue button next to the object’s rendering intent. 
2. Check the boxes for each color channel that you want to preserve unmixed. 

Click All On to check all color channels, or All Off to clear all channels. 
2. Click OK. 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

 
The following options are available: 

Remove Moiré   Click to recalculate angles and frequencies to remove Moiré patterns. 
This function recalculates the angles and frequencies of the CMY color channels 
based on the angle of the black color channel. All other color channels will remain 
unchanged. 

 
Screen To set the screen angle and frequency for a color channel, select the channel in 

the list  
 
Angle and Frequency and click Edit. 

Enter the angle and frequency desired, then click OK. Check Apply to All to 
apply the new frequency to all color channels.  

 
Shape  The shape of the dots that make up the halftone screen. For best results, choose 

either Diamond or Ellipse. 
 

Use Accurate Screens If checked, a special algorithm is used that produces highly 
accurate halftones, but is computationally expensive 

Supercell  If checked, supercell halftoning will be used. Supercell halftoning produces  

 

 

 

 

Setting Dither Options for Angled Screens  
The Angled Screens dialog displays the 

dither options that are available for angled 
screens. To access the dialog, select 

 
Angled screen as your dithering option in the 

Printer tab of the Job Properties dialog, 
and click on the Screen button. 
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halftones that Halftoning have four times the shades of gray at the same 
resolution compared to standard algorithms. This creates smoother images 
when printing angled screens. However, the amount of processing needed to 
generate halftones is increased. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Nesting Jobs 
The software has the ability to nest jobs together in order to minimize the amount of material 

needed to output the jobs. Nesting reorganizes the jobs on the output media so that they line up 
across the media width and are packed into as compact an area as possible. Jobs must be in the 
same queue in order to be nested together, and must share the same output device and resolution. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Nesting Jobs Manually 
To nest jobs: 

1. Select the jobs. 
2. From the File menu, select Nest Jobs. 

If a single job is selected, its pages will be nested. 
 

Un-Nesting Jobs 
To separate a set of nested jobs into its component jobs: 

1. Select the set of nested jobs. 
2. From the File menu, select Unnest Jobs. 

Using Automatic Nesting 
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The software can be set to automatically nest jobs as they are added to the Hold Queue. To 
set up automatic nesting, from the Setup menu select Setup Properties, then select the Automatic 
Nesting tab. 

 

Automatic job nesting 
      Automatically nests jobs using one or more of the 

criteria specified below. This allows you to work more efficiently 
by grouping their jobs for output. You can add several jobs into 
the queue and nest them into one job. 

Number of jobs 
Select this option to automatically nest jobs once the  
specified number of jobs has accumulated in the queue. 

Number of minutes 
Select this option to automatically nest jobs once the 

specified number of minutes has passed. 
Percent coverage Daily at  

Select this option to automatically nest jobs once the 
specified percentage of the media has been covered.  
Select this option to automatically nest jobs once a day at  
the specified time. 

Automatic rotate image when nesting 
If checked, the images may automatically be rotated when  
nested so that less of the output media will be used up.  

Set Number of jobs to 1 
Automatically nest pages, tiles and separations. 

 
Nesting Pages, Tiles and Separations 

The software is able to nest the pages of a multi-page job so that they line up across 
the width of the output media and take up less material. 

To nest the pages of a multi-page job: 
1. On the Layout tab of the Job Properties dialog for the job, check Page 

Nesting. 
2. Select the job. 
3. From the File menu, select Nest. 

 
Rearranging Nested Jobs 

The software allows you to rearrange a set of nested jobs using the Job Properties 
dialog. You can move, rotate and mirror the jobs. To rearrange a set of nested jobs, select 
the set of jobs and from the File menu, select Job Properties. In the Job Properties dialog, 
select the Layout tab. A red border appears around the edges of the selected image. 

 
Moving Images 

To move a nested image, click and drag the image in the preview pane of the Job 
Properties dialog. 

 
Rotating Images 

To rotate an image 90°, select the image and click on the Rotate Image button. 
Clicking the button a second time will toggle the image back to its original orientation. 

 
Mirroring Images 

To flip all images along their vertical axes, click on the Mirror Image button. The 
images are flipped, but their positions on the output media do not change. 
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5.15 Shutdown Procedure (Applicable it the machine will not operate for more than 4 days) 
Ø Shut-off the UV lamps. 
Ø Shut-off the negative pressure valves. 
Ø Shut-off the power for machine and PC. 
Ø Disconnect the printhead input linr from the Ink Supply line. 
Ø Connect the printhead input line to the syringe filled with clean applicable flushing 

solutions. 
Ø Slowly push the flushing solution out of the Print head to gradually remove the ink 

presence on the Print head.  
Ø Continue flushing the print head until a clear flushing solutions are jetting out of the 

printhead nozzles. 
Ø Re-connect the printhead input tubings to ink supply line. 
Ø Do the same procedure on other Printheads. 
Ø After completing the flushing of all the Print head, prepare the Print head Capping material. 
Ø Pour Flush solution to the lint free cloth on top of the prepared print head capping material. 
Ø Install the Print head Capping into the bottom of the Print head Carriage securing it with 

the cling wrap which is wrapped-around the print head carriage 
Ø Wipe-off any ink contamination. 
Ø Turn off the Main Power switch. 
Ø Close the left case cover. 
Ø Switch-off the ventilation and lighting in the printing room if necessary. 
Ø Perform Housekeeping if necessary. 

 
5.16 Overnight Shutdown 

Ø Shut-off the UV lamps 
Ø Shut- off the negative pressure valves. 
Ø Shut-off the power for machine and PC 
Ø Close the machine covers 
Ø Do housekeeping if necessary 
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Chapter 6  - Service and Maintenance Procedure 
 
 
6.10 Brief Introduction 

This is to describe the various service and maintenance procedure to be observed in using this 
machine 

 
6.11  Flushing a Selected Print head  

−  Disconnect the connection of the Ink Tube Inlet from the Ink Supply line, insert the 
tubing of the Syringe with the compatible solvent inside. 

−  Slowly push the solvent out of the Print head and check if all the nozzles are 
working well. 

−  Continue flushing out until all the printhead nozzles are showing straight jetting of 
flushing solution. 

−  Reconnect the Ink input tubing to the supply line, Do Ink prime by activating the 
toggle switch. 

−  Click the Auto Clean Mode on the RTZ software to auto-clean the Print head. 
−  Wipe the Print heads with a lint-free cloth to removed excess ink residue around 

the Print heads. 
 
6.12 Replacing the Print head 

• Turn-off the printer power. 
• Perform the Flushing procedure on the Print head that needs to be replaced. 
• Remove the 30pins Print head flexible data cable. 
• Remove the Print head Connect card by removing the two screws securing this card 
• Remove the two screws which secure the print head from the print head carriage. 
• Remove the Ink Inlet and Ink bleed tubing from the Print head’s ink supply and bleeding port. 
• Safe keep the old Print head. 
• Install the new Print head to the Print head accordingly. 
• Replace the two fixation screws of the Print head.  
• Connect the Ink Inlet and Ink bleed tubing to the new Print head’s accordngly. 
• Install the Print head Connect Card on top of the Printhead, securing it with two screws. 
• Install the 30pins Print head flexible data cable. 
• Perform Flushing procedure to make sure that all jets are working well. 
• Turn on the printer power. 
• Perform Ink Priming 
• Click the Auto Clean Mode on the RTZ software to auto-clean the Print head. 
• Wipe the Print heads with a lint-free cloth to removed excess ink residue around the Print 
  heads nozzle. 

 
6.13 Maintenance of Ink Supply and Vacuum Line System 
 

• Check the ink supply line system specifically the connectors, plugs and valves for any traces of 
leakages or broken plastic tubing. 

• Check and clear any traces of ink or solvent flow from the ink protect tank. If overflow happens, 
clean the affected line immediately. Check possible traces of leakages and fix them accordingly. 
Ink dripping or starving will happen on the print head as a result of unstable vacuum line system. 
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6.14 Changing Defective Ink Pump and Filter 
          Usually, the ink pump stops pumping the ink when the secondary tank is full of ink. The    
    level sensor will energize the LED on the Print head Control Board when the secondary ink tank is     
    full.  

  If the LED doesn’t light after 2 mins of pumping, then most likely the pump is defective or 
there’s a leak somewhere along the input line. Please take note of the polarity of the power supply 
cable for the ink pump; usually the Red wire is connected to positive “+” while the black is to 
negative “-“. 
 Change the ink and solvent filters every three months or approximately 800 operational 
hours to ensure continuous ink and solvent flow into the system 

 
6.15 Changing Defective ink and Vacuum Pump 

  If the time for the ink to reach the secondary ink tank is longer than normal, the      
   pump might be defective or it might be a leaking problem. When changing the Ink Pump, take     
   note of the polarity of the power supply cable and the direction of the arrow head for tubing  
   connections. 
 
 
 
 
 
 
 
 
 
 
 

 
  Likewise, when the ink priming pressure becomes weak and the negative pressure will go  
    down below -2.0 reading, the air pump is defective or there might be some leakage somewhere in    
    the vacuum line system or the 4/2 way valve is malfunctioning. Usually, the vacuum pump can  
    attain 20-30KPa pressure when you do ink priming. When changing the vacuum pump, you must  
    take note of the power supply cable and flow direction of air is determined by the arrowhead on  
    the pump. 

 

 
6.18 Maintenance of Printer Moving Parts 

           Clean and lubricate the Print head Carriage Rail on a weekly basis. Apply enough light   
      duty grease or oil in the contact area. 
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                Clean and lubricate the slide bearing, ball bearings for timing belt pulleys, gears and                 
           ball bearing for automatic take-up system and pinch rollers on a weekly basis. 
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Chapter 7  - Appendices 
 
 

Appendix A 
Material Safety Data Sheet for UV Inks 

 
 

 
SECTION 1: Chemical Product And Company Identification 
PRODUCT NAME: VUV-Yellow/Magenta/Cyan /Black/LightMagenta/LightCyan  
PART NO:  VUV-Y /VUV-M/VUV-C/VUV-K/VUV-LM/VUV-LC 
SUPPLIER:  SHINY COLOR INKS INC. 
AGENT:  XUKE Advertising Equipment Inc. 

      Shenzhen, Guangdong China 
TEL NO:         0086-755-84150772 
FAX NO:  0086-755-84150773 
 
 
SECTION 2: Composition/ Information of Ingredients 
INGREDIENT NAME       CAS NO       CONTENTS    HEALTH RISK 
Organic Pigment       2.0-6.0 % 
Ester Resin                                 0.1-5.0 % 
Vinyl Resin                                 1.0-8.0 % 
Cyclohexanone             108-94-1     1.0-5.0 %     Xn 36 
2-Butoxethyl acetate       112-07-2       60-80 %    Xi 20/21 
DE-Acetate                112-15-2     10-20 %    Xi 37/41 
N-Methyl Pyrolidinone      872-50-4    1.0-5.0 %       Xn 36 
SECTION 3   Hazard Identificati ion 
HEALTH: Harmful if inhaled or adsorbed through skin and irritating to eyes 
FIRE:         Product is not classified as flammable. 
 
 
SECTION 4   First Aid Measures 
GENERAL ADVICE: Please call hospital emergency in case of any accident that is not instructed how to 

handle 
 
INHALATION:   Take the victim to the place for fresh air at once 
 
INGESTION:    Call hospital emergency 
 
SKIN:            Wash skin with clean water immediately 
 
EYES:           Make sure to remove any contact lenses from the eyes before rinsing. Rinse at least 15 

minutes. Call hospital emergency if still feel uncomfortable 
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SECTION 5 Fire Safeties 
EXTINGUISHER:  Use Foam, Carbon dioxide (CO2) Powder.  
PROTECTION EQUIPMENT: Wear mask and safety glasses  
 
 
SECTION 6   Handling ink spillage   
PERSONAL SAFETY:  Use protective gloves and mask; avoid contact with skin or eyes. 
SPILL CLEANUP METHODS:  Apply toilet paper 
ENVIRONMENTAL PRECAUTION: Avoid pouring waste ink into tap water drainer and soil. 
 
 
SECTION 7 Handling and Storing 
USAGE PRECAUTIONS: 
Keep container sealed.  
Provide good ventilation.  
Avoid spilling, skin and eye contact. 
Avoid inhalation of vapors. 

 
STORAGE PRECAUTIONS 

• Keep in cool, dry, ventilated storage and sealed containers.  
• Protect from light, including direct sunrays.  
• Keep away from heat and flame. 
• Store away from oxidizing material, alkalis, acidic. 

 
 
SECTION 8   Exposure Controls and Personal Protection 
INGREDIENT NAME     CAS No       STD      LT EXP     ST EXP  
                                  (8 hrs)      (15min) 
Cyclohexanone  108-94-1    25ppm                  NE 
2-Butoxethylacetate 112-072     25ppm                  NE 
DE -Acetate              112-15-2    25ppm                  NE  
N-Methyl Pyrrolidone     872-50-4                   NE                      NE 
 
 
INGREDIENT COMMENTS:    
      OES = Occupational Exposure Standard. 
PROTECTIVE EQUIPMENT: 

                     
 
PROCESS CONTROL MEASURES: Use engineering controls to reduce air contamination to permissible                            

exposure level. Provide eyewash station. 
VENTILATION:  Provide adequate general and local exhaust ventilation. 
PROTECTIVE GLOVES: Use suitable protective gloves to reduce risk of skin contact. 
EYE PROTECTION:  Use approved safety glasses or mask. 
OTHER PROTECTION: Wear suitable protective cloth for protection against splashing or contamination. 
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HYGIENIC WORK HABITS: Wash hands at the end of each work shift, before eating, smoking and using the 

toilet.   
Change cloth that becomes wet. Isolate contaminated cloth and wash before 
reuse. Use appropriate hand lotion to prevent aging and cracking of skin. No 
eating or drinking while working with this material. 

 
 
SECTION 9 Physical and Chemical Properties 
Existing form:        Liquid         
Color:        Yellow/Magenta/Cyan/Black 
Boiling degree:       191 
Flash degree:        88 
Auto ignition Temperature:      no data 
Flammability limits (vol %):      no data 
Relative density (g/cm3,25):      not determined 
Solubility in water (g/l,20):      not soluble 
 
 
SECTION 10: Stabil i ty and Reactivity 
Stability: Stable under normal conditions in tightly closed container decomposition if used according to     
                specifications. 
Materials to Avoid: Avoid contact with oxidizing materials, strong acids, strong bases, air or oxygen. 
Hazardous Polymerization: Not relevant. 
Conditions to Avoid:   Avoid sources of ignition 
 
 
SECTION 11:  Toxicological  Information 
INHALATION:    Gas or vapor in high concentrations may irritate respiratory system. 
SKIN CONTACT:  Acts as a defeating agent on skin may cause cracking of skin. 
EYES CONTACT: Primary irritant effect may cause severe irritation to eyes. 
INGESTION:   Low acute oral toxicity. 
 
 
SECTION 12:  Environmental Information 
MOBILTY:  Partly miscible with water. 
BIO ACCUMULATION: Bio accumulation unlikely. 
DEGRADABILITY: Readily biodegradable. Do not allow product to reach ground water course or  
                        seawage system. 
 
 
SECTION 13:  Disposal Considerations 
GENERAL/CLEANING:  

Refer to Section 7 before handing the product or containers. 
 

DISPOSAL METHODS:   
Disposal must be in accordance with current national and local regulations. Chemical residues generally 
count as special waste. 
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SECTION 14:   Transport Information 
GENERAL:   Not regulated. 
LABEL FOR CONVEYANCE: No transport warning sign required. 
ROAD:                     
HAZARD CLASS (ADR):       Not classified for transportation. The product is not subject to transport  
                                regulations of Rail, Sea, Air. 
 
SECTION 15:   Regulatory Information 
LABEL FOR SUPPLY:   
                       
 
DANGER SYMBOL:   
Xn   (Harmful) 
RISK SYMBOL:   
R-36:  lrritating to eyes. 
R-21:  Harmful by inhalation 
R-20:  Harmful in contact with skin 
 
SAFETY PHRASES:   
S-25   Avoid contact with eyes. 
S-26   In case of contact with eyes, rinse immediately with plenty of water and seek medical advice. 
S-28  After contact with skin, wash immediately with plenty of water. 
S-36/37/38 Wear suitable protective cloth and gloves and eye/face protection 
S-60   This material and its container must be disposed of as hazardous waste. 
 
 
SECTION 16   Other Information 

This data sheet is prepared in accordance with directive. The information on this sheet is intended to 
provide general guidance to health and safety based upon our knowledge of the handling, storing and using 
of our products. It is not applicable to other products. 
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Appendix B   Preventive Maintenance Checklist 
 

Item Daily Weekly Monthly Quarterly Semi-annual Annual 
Ink Supply Level Check and shake 

on startup 
     

Waste Ink Bottle Check for level, 
dispose if full or 
nearly full 

     

Ink Filters    Change   

Ink Pumps    Check and 
replace if 
necessary 

  

UV Lamps   Check and 
change if 
necessary, left 
UV lamp and 
right UV lamp at 
the same time 

   

UV Lamp Filters  Check and Clean     

Flat Bed 
Conveyor 

 Clean     

Carriage Linear 
Guide Rail 

 Check, Clean 
and Lubricate 

    

Carriage Bearing  Check, Clean 
and Lubricate 

    

Carriage Belt     Check the 
tension, adjust 
tension if 
necessary 

 

Y-feed conveyor 
drive gear head 
oil 

    Oil change Oil Change 

Vacuum Cleaner 
and Filter Bag 

 Check for waste 
ink level and 
Clean if 
necessary 

   Change Filter 
Bag 

Cleaning Station  Check and Clean     

Raster 
Strip/Ruler 

Wipe with lint free 
cloth before 
startup 

     

Automatic 
Carriage Height 
mechanism 

Check if spring is 
functional (The 
plunger should 
return at  
up/home 
position) 

     

 
Note: 500 Hrs after installation, the Y-feed conveyor drive gear head oil should be changed. 
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Appendix C   Troubleshooting Guide 
 

Problems Probable Causes Solution 

v One particular 
color is not 
printing 

o No ink flowing to the tube line 
of the Print head Carriage  

o Empty ink supply in the Ink 
barrel 

o Clogged Ink line tubing and 
ink filter 

o Defective Ink Pump 
o Defective Print head Control 

Board 
o Defective Motion Control 

Board 
o Air bubbles on the ink tube 

1. Fill-up empty ink barrel 
2. Replace clogged ink line tubing and ink 

filter 
3. Replace defective Ink Pump 
4. Replace defective Print head Control 

Board 
5. Replace defective Motion Control Board 
6. Purge air from the affected ink tube. 

 

1. Some Print head 
Nozzles are not 
firing 

2. Print head firing 
is not straight 

 Clogged Print head 
  Print head problems 
  Defective Print head Cable 
  Defective Print head Control    

Board 

• Perform Ink Priming 
• Replace defective Print head  
• Replace defective Print head Cable 
• Replace defective Print head Control 

Board 
• Adjust the Print head Voltage 

v Ink Starvation 

o Insufficient Negative 
Pressure value 

o Print head nozzles are not 
working well 

o Insufficient ink flowing from 
the Disc Filter to the Print 
head because of clogged 
disk filter 

§ Increase the Negative Pressure value 
from  

     -2.2KPa to -2.6KPa 
§ Perform Test Print to check if all the Print 

head nozzles are working well, flush and 
ink prime as needed 

§ Replace Filter 

v Cannot achieve 
correct negative 
pressure 

v Negative 
pressure keeps 
on changing from 
time to time 

o Presence of ink in the Ink 
Protect Tank  

o Defective Negative Pressure 
Regulator 

o Defective Pressure Gauge 
o Defective Air Pump  
o Possible leak in the vacuum 

line system (negative 
pressure line) 

§ Remove or purge any presence of ink in 
the Ink Protect Tank 

§ Replace defective Negative Pressure 
Regulator 

§ Replace Pressure Gauge 
§ Replace Air Pump 
§ Fix any air leak from the vacuum line 

system.  
§ Replace Air Fittings if necessary 

v Air Pump is not 
working 

v Ink Pumps are 
not working 

o Presence of ink in the Ink 
Protect Tank  

o Ink Tank Sensor might not be 
working that is why ink is 
overflowing to the Ink Protect 
Tank 

§ Fix/replace the Ink Tank Sensor 
§ Remove the ink from the Ink Protect Tank 

using the Syringe from the Ink Outlet 
Tube vent 

v All Ink Pumps 
are not working 

o Presence of ink in the Ink 
Protect Tank  

o Defective / Out of Position  
Ink Protect Level Sensor 

§ Remove or purge any presence of ink in 
the Ink Protect Tank 

§ Replace/Fix Ink Protect Level Sensor by 
opening the Ink Protect Tank 
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v No Print at all 
v No presence of 

Printhead 
Voltage from 
RTZ software 

o The Optical Cable must have 
been interchanged during 
installation 

§ Interchanged again the Rx/Tx connection 
of the Optical Cable either from the PCI 
card or in the Printhead Control Board 

v Carriage gets in 
contact with 
media during 
printing 

o Gap between carriage and 
media (printing platform) is 
too close. 

o Media suction is not working 
o Wrinkled / curled media 

§ Adjust the Printer Carriage between 2.0 – 
2.5mm. 

§ Check the 24V supply of suction fans, 
replace defective suction fan if necessary 

§ Replace the media to avoid wrinkled 
media to be in contact with the print head 
during printing 

v Carriage is not 
moving, left to 
right stroke 

o Defective AC Servo Motor 
o Corrupted/Defective Servo 

Driver 
o Worn-out Timing Belt 
o Defective Motion Control 

Board 

§ Replace defective Servo Motor 
§ Re-program the Servo Driver, replace if 

defective 
§ Replace worn-out Timing Belt 
§ Replace Motion Control Board 

v Media is not 
moving, 
backward and 
forward stroke 

o Defective DC Servo Motor 
o Defective Movement Control 

Board 
o Worn-out Timing Belt 
o Defective Motion Control 

Board 

§ Replace defective DC Servo Motor 
§ Replace worn-out Timing Belt 
§ Replace Movement Control Board\ 
§ Replace Motion Control Board 

v Ink is not drying 

o Heat is not enough to dry the 
ink 

o Heater is not working 
o Heater controller is not 

working 
o Density or the ink limits of 

the image setup is too high 

§ Increase the heater’s temperature from 
the printing platform as well as the front 
heater 

§ Replace defective heater 
§ Replace heater controller 
§ Lower the ink limits  of the image profile 
§ Decrease the Ink limits of the image 

v Horizontal 
banding 

o Clogged Print head 
o Step alignment is not good 
o Print head alignment is not 

good 

   Perform solvent flushing and Ink Priming 
(make a  

longer flushing if needed) then check 
the status of the Print        head in Test Print. 

     
       Adjust the motor steps (see Print head 
Alignment  
       Procedure) 
       Aligned the Print head very well (see Print  
       head Alignment Procedure) 

v A particular 
portion of the 
printer is 
showing 
horizontal 
banding 

o Feeding of the Pinch Roller 
is not equal 

Ad                  
       Adjust the tension of the Pinch Roller 
       (see Pinch Roller Adjustment Procedure) 
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v Inconsistent step 
align problem 

o Feeding of the Pinch Roller 
is not equal 

o Worn-out Gear Box 
Assembly 

o Defective Motor Encoder 
o Worn-out Timing Belt 

      Adjust the tension of the Pinch Roller (see 
Pinch Roller  

       Adjustment Procedure) 
       Replace worn-out Reducer Gear Box 

Replace Y-Axis Servo Motor 
       Replace Timing Belt 

v Vertical Banding 
on the right side 
portion of the 
machine 

o Raster Strip might have 
scratches on that portion 

o Loose connection on the 
Print head Cable Data lines 

o Tension on energy chain 
assembly 

§ Replace the Raster Strip 
§ Fix loosed Print head Cable Data lines 
§ Fix/replace the energy chain 
§ Re-setup and cabling on the energy 

chain 

v Carriage 
suddenly stops 
during operation 

v X-alignment 
problem during 
printing 

o Raster Strip is too dirty 
o Portion of Raster Strip has 

severe scratches 
o Defective Raster Strip 
o Defective Raster Encoder 
o Raster Encoder is not 

properly setup with raster 
strip 

§ Clean Raster Strip . 
§ Replace defective Raster Strip 
§ Replace defective Raster Encoder 
§ Perform Raster Alignment  

v Portion of the 
RIPed image 
was not printed 

o The RIPed image dimension 
is almost /more than 
2000in/50m. 

o The RIPed image file is more 
than 4G bytes 

§ Reduce the size to be RIPed to 
manageable size to avoid RIPing error 

v Output size of 
the image print is 
not same with 
the defined 
image dimension 

o Tension Roller problem 
o Needs to perform Output 

Size Compensation  

§ Adjust/setup the roller tension properly 
§ See page 48 for proper procedure in 

using Output Size Compensation 
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Appendix D   Glossary 
 
Adobe Acrobat - Software package created by Adobe for converting any document to an Adobe Portable  
          Document Format (PDF) file. Anyone can open your document across a broad range of hardware 
          and software using the downloadable, free software Adobe Acrobat Reader, and it will look  
          exactly as you intended—with layout, fonts, links, and images intact.  
 
Aliasing - A defect which occurs when a graphic file does not have enough resolution to reproduce image  
         detail and causes visible jagged lines along the edges 
 
Attachment - When referring to e-mail, an electronic file placed within an e-mail for the purpose of sending  
          through the Internet. 
 
Banding - It is the horizontal, parallel lines in an ink jet print caused by a falsely aligned or defective print    
          head. It is also the vertical lines caused by some mechanical problem. 
 
Bi-directional Printing - Printing in which the print head alternates printing a line left to right, then the next  
          line right to left, etc. 
 
Bitmap Images  - Computerized image made up of a collection of dots or pixels; these images appear  
          blocky when you zoom in; also known as raster images 
 
Bleed - Ink which prints beyond the trim edge of the page, created for the purpose of allowing ink to extend  
          to the edge of the page after trimming. Without bleed, cutting the product becomes extremely  
          difficult and may sacrifice the quality of the product.  
 
CMYK - cyan, yellow, magenta, black. The subtractive primaries, or process colors, used in color printing.   
        Black (K) is usually added to enhance color and to print a true black.  
 
Color Bar - Strips of color used as a tool to check color accuracy and density 
 
Color Mapping - The terminology that permits the “best match” in appearance to the “source image”. 
 
Color Separations - The process of preparing artwork, photographs, transparencies, or computer-generated  
         art for printing by separating color into the four primary printing colors: cyan, magenta, yellow and  
         black. 
 
Contrast:  The comparing of light and dark on an image, such as low = gray (light). 
 
Crop - To cut off parts of a picture or image. 
 
Crop marks - Printed lines showing where to trim a printed sheet.  
 
Densitometer - A quality control devise used to measure the density of printing ink.  
 
Density - The degree of color or darkness of an image or photograph.  
 
DCM Driver Chip Module - Part of Spectra 96 chip print head. Consists of a printed circuit board with driver  
        chips, attached to a lead frame of sprung legs that are pushed into contact with pads on the PZT. 
 
Dithering: Creating dots to “fool the eye” into seeing shades of gray. 
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Dot Size - Relative size of halftone dots as compared to dots of the screen ruling being used. There is no  
       unit of measurement to express dot size. Dots are too large, too small or correct only in comparison  
       to what the viewer finds attractive.  
 
Dots-per-inch - Measure of resolution of input devices such as scanners, display devices such as monitors,  
       and output devices such as laser printers, image setters and monitors. Abbreviated DPI. Also called  
       dot pitch. 
 
Drop-On-Demand (DOD) / impulse - an ink jet system in which pressure pulses are generated directly in  
       the print head by piezo crystals or heated resistors to eject drops of ink only when they are needed to  
       print a dot 
 
Drop Mass or Drop Volume - The size of a jetted drop of ink, usually measured in nanograms. Adequate  
       jet-to-jet drop mass uniformity is required in many applications to eliminate banding When the  
       specific gravity is 1, 1picoliter (pL) = 1 nanogram (ng). 
 
Drop Velocity - The speed at which a drop of jetting fluid travels from the orifice plate to the receiving  
       medium. 
 
Encapsulated Postscript File (EPS) - An Adobe graphic file format for high resolution images; it translates  
       graphic and text into code that tells a printer to print in the highest resolution possible and also has  
       low resolution view files for quick screen viewing. 
 
Encoder - An encoder is a device or transducer that converts linear or rotary motion information into  
      uniformly spaced incremental signals. 
 
First In First Out (FIFO) - A form of low-level memory (for example, a shift register. Used in the data path for  
       temporary storage of bitmap data on its way to a print head. 
 
Fire Pulse - A high voltage electrical signal of precise shape, amplitude, and width, causing a jet to eject a  
     drop. Also called a drive pulse. 
 
Firmware - Embedded software, i.e., software that is not loaded from a storage device at startup, but instead  
       resides on the board or in the chip. 
 
Fire Pulse Amplitude (FPA) - The peak voltage of a fire pulse. 
 
File Transfer Protocol (FTP) - The language used to facilitate the transfer of files from a server on the  
         Internet to another location, such as a desktop computer or another server. 
 
GIF Graphic Interchange Format - An image format type generated specifically for computer use. Its  
        resolution is usually very low (72 dpi, or that of your computer screen), making it undesirable for  
         printing purposes. 
 
Gradient - Color in shades from one starting point to another gradually blending in between. A grade change  
        in a hue. It is a transition of color, creating a blended change between screen percentages of a  
        single color or between two different colors  
 
Grain - The direction in which the paper fiber lie.  
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Head Drive Electronics Module (HDEM) - This is the component of the Apollo PSK that creates the high   
        voltage drive pulses. It is programmable for pulse amplitude and width, as well as rise and fall time. 
 
Hypertext Markup Language (HTML) - A series of formatting commands that describes the components of  
        graphics and text material presented on the World Wide Web in a consistent manner 
 
Image Area - Portion of paper on which ink can appear. 
 
Image - Usually a photograph that is “translated into a bitmapped” image by scanning Ink Jet Printing  
       Method of printing by spraying droplets of ink through computer-controlled nozzles. Also called jet  
       printing. 
 
Initialization File - A file, usually with the extension .INI, that sets startup variables for an application  
       program. 
 
Large Format Printing - refers to large sized prints, typically A1 sized or larger, produced in full color  
       utilizing full color digital ink jet printers. 
 
Materials Safety Data Sheet (MSDS) - This is a document which describes the potential safety hazards of a  
       chemical, liquid or solid, and instructs how to handle it safely and how to respond to exposures or  
       spills.  
 
Meniscus -  The curved surface at the top of the water column, or at any interface between a liquid and a  
       solid. Nozzles have a meniscus, whose shape and position are set by a slight negative pressure in  
       the jets at rest, balanced against the surface tension of the liquid. 
 
Meniscus Pressure Used at Spectra - the meniscus pressure often refers to an inward bubble pressure  
       that equals the fluid pressure at a print head jet nozzle when that jet is not activated. A negative  
       meniscus pressure is applied to inactivated jets only when the print head system is operating,  
       helping to prevent the jetting fluid from leaking at the nozzles. More generally, meniscus pressure is  
       the negative pressure created behind a meniscus, due to surface tension. 
 
Portable Document Format (PDF) - An electronic document format from Adobe that allows the distribution  
      of digital files across any platform that can display a document as originally designed and formatted  
      without having the software application or fonts on the viewing computer. 
 
Pigment - Particles that absorb and reflect light and appear colored to our eyes; the substance that gives ink  
       its color. 
 
Pixel - A single dot on a monitor or on digital image. 
 
Print head - part of a digital printer that is directly responsible for applying ink to a substrate 
 
Protocol - The set of conventions defining communication between electronic components, for example, and  
       a host computer and its interface. The way information is placed on a network. The steps needed to  
       communicate or activate an operation or exchange of information in or between computers. 
 
Purge - Performed for a variety of print head maintenance reasons, a purge is a regulated pressure applied  
       for a fixed amount of time at the air interface to the ink reservoir attached to the print head jetting  
       assembly to force ink, along with air bubbles and debris if present, out the jets through the nozzles. 
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Raster - A line of pixels. Also, the process of rendering an image or page, pixel by pixel, in a sweeping  
        horizontal motion, one line after another. 
 
Rasterization - The process of converting mathematical and digital information (vector commands) into a  
        series of dots by an output device.  
 
Raster Image Processor (RIP) - A combination of computer software and hardware that controls the printing  
        process by calculating the bit maps of images and instructs the printing device to create the images.. 
Most RIPs operate on PostScript.  
 
Resolution - The DPI or dots per inch of a design. Measured by how many dots or pixels are in one inch of a  
        design. The measurement of the fineness or detail. The higher the resolution the finer the detail in  
        an image 
 
Satellites - Small droplets of jetting fluid generated behind the main drop as the main drop detaches from  
        the nozzle. 
 
Substrate - Any surface on which printing is done. 
 
Tagged Image File Format (TIFF)  - A standard graphic image file format often used for storing high  
        resolution images that can easily handle up to 24 bits of photographic image color. 
 
Transmission Control Protocol/Internet Protocol (TCP/IP) - is an open communications protocol 
        implemented on diverse systems and the Internet and is the preferred protocol for practical  
        interoperability. 
 
Varnish - A clear liquid coating applied to printed sheet for protection and glossiness. 
 
Varnishing - a finishing process whereby a transparent varnish is applied over the printed sheet to produce  
        glossy finish. 
 
Viscosity - the tendency of a liquid to flow slowly or quickly resulting from the friction of its molecules 
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